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Basics

Service Pack 2 2016 (V 2102)

Important note on updates!
When you run the tool Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) – either during
installation (Extended Settings > User Configuration tab) or later – various system files in the HiCAD sys dir-
ectory will be replaced (without any further query!) with the files supplied in the HiCAD templates directory
which have been designed especially for a working with the selected module and the activated checkboxes
(e.g. DSTV or Management + BIM). These files include, for example

n HiCAD masks for the part attributes (*.HDX),

n HELiOSmasks for projects, documents and articles (*.MSK),

n Various configuration files (*.HDB) and

n Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the ParKon-
figComp.exe tool!

If you have any questions, please contact your nearest ISD branch office.

STB_PARAMETER.DAT -> Configuration Editor
In previous versions various settings for Steel Engineering could be specified in the STB_PARAMETER.DAT, which
is now no longer available. Its setting options can now be found in the Configuration Editor at Steel Engineering.

Therefore, the corresponding settings have been removed from the dialogue window that is open via > Settings.

Insert Parts/Variants - Improved preview
When you insert parts and variants, a shaded representation of them will be displayed before their placement in the
drawing. This facilitates the placing in the drawing.

The representation type for fitting point determination on the part will not be influenced by this - this parameter can
still be set in the Configuration Editor at System settings > Visualization > Views > Insertion view.

The changes concern various functions throughout all industries, e.g.

n all functions at Drawing > Insert Part,

n the pasting from the Clipboard,

n the creation of base sheets,

n the attaching of flanges via sketches,

n the moving and rotating of objects,

n the insertion of Standard Parts,

andmuchmore.
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Example: Insertion of a solid primitive

Example: Fitting point specification in drawing for "Clone + Move"

Furthermore, the function dialogue has been changed. When HiCAD prompts you to specify a fitting point in the
drawing, you have now in many situations the option to right-click and open a context menu with further functions.
For instance, you can use the Origin function to apply the origin of the active coordinate system.
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Point selection with the Autopilot
n The HiCAD Autopilot can now also snap quad points.

n When specifying points with the HiCAD Autopilot, the found points and the original geometry relevant for point
specification are now highlighted in a different colour (Special colour, Marking 1), e.g. the circle for quad points,
the arc/circle for centres, or the line for mid points.
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BOMs

The dialogue windows for the functions Bill of Materials, for entire drawing  and Bill of Materials, for active

assembly have been revised. In the selection boxes for Head data and the Item data, the name of the cor-
responding HB file will no longer be shown, but an explanatory text that is linked to the corresponding HDB file.

Bill of Materials (BOM) dialogue window

When creating BOMs for the active assembly, you have now the option to transfer the attributes of the drawing as
head data.
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If you have previously used your own control files, e.g. individual HDB files, for the BOM output, you can still use
them if you want. In this case, please read the information given in the BOM Output with Individual Control Files
topic.

RAL colours
RAL colours were previously defined in the system file RALRGB.DAT. As of SP2, this file is no longer available;
instead, you will find the RAL colours in the Catalogue Editor at Textures and Colours > Colours > RAL CLASSIC.

RAL CLASSIC colour table

Renamed colour configuration file
In Version 2014 the predefined Marking colours have been changed. The previous name of the corresponding con-
figuration file was hicad_2014.hcf. This file has be renamed to hicad.hcf.
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Load/Save
When loading and saving files, access to network directories is now established much faster. This applies in par-
ticular to slow networks with a large number of files.

Service Pack 1 2016 (V 2101)

Start HiCAD

Catalogue directory check

The version of the utilized catalogue directory will be checked upon HiCAD start. If the catalogue directories are old
there is a risk that HiCAD will search for catalogue entries which do not yet exist in the old catalogues. One
example of this are the Textures that were integrated in the catalogue some time ago. If these are missing in the
catalogue, you will have no access to these textures in HiCAD.

If you start HiCAD with an old catalogue directory (e.g. HiCAD 2100.1 with Catalogue 2100.0 or HiCAD 2100.0 with
Catalogue 2002.2), a corresponding message will be displayed:

If the version of the catalogue cannot be detected, the following message will be displayed:

User interface

Zoom functions

The Zoom functions have been removed from the Ribbon. You can still access the functions via the transparent tool-
bar and the shortcuts.

Customize transparent toolbar

You can now use the UserInterfaceEditor.exe tool to customize the transparent toolbar.

20 / 278 ISD Group - HiCAD 2016

Basics



Furthermore, you have now the option add functions to your own Ribbon tabs that were previously only available in
the transparent toolbar or in the QuickAccess toolbar. Examples of such functions are:

n Show all parts and Show only active part

n Redraw (incl. Reshade and Recalculate active view from the sub-menu)

n Zoom functions

n 3-D processing plane (incl. sub-menu)

n Find (Part filter)

Load/Save
The dialogue for the loading and saving of files has been revised.

Hide/Show columns

The columns of the file list can now be hidden and redisplayed. Right-click on a column header and select the
desired column from the context menu. (1)

Structure tree

The structure tree in the navigation area has been slightly modified. (2)
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Others

n To remove a folder stored for Quick access, first activate the Quick access option in the navigation area. Right-
click the object you want to remove and choose Remove from Quick access.

n Click the arrow symbol next to the file name to open a selection box with a History / History (Explorer) list.
Beneath History, all files that were last opened in/saved to HiCAD are shown; beneath History (Explorer), the
files that were all files that were last opened in/saved to the Windows file Explorer are shown.

Other changes

Scale-dependency of 3-D hatchings

The new Hatching, Scale- dependency function for hatchings allows you to specify for 3-D hatchings
whether they should be scale-dependent or scale-independent. You can find the function on the Drawing tab, at
Properties > Attr. > ... as well as in the context menu of the drawing.

The default setting is Scale-independent. With this setting, the spacing between the hatching lines will always be
the same, no matter which scale was selected.
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If you want the hatching line spacing to be scaled together with the object in case of scale changes, choose the set-
ting Scale-dependent.

The default setting shown in the dialogue window can be changed in the Configuration Editor, at System settings >
Visualisation > Scale dependent 3-D hatching.

Example

Revised dialogue windows for BOMs and weld seam test protocols

The dialogue windows for the functions

n BOM for entire drawing,

n BOM for active assembly,

n BOM Settings,

n Weld seam test protocols for entire drawing, and

n Weld seam test protocol for active assembly

have beenmodified.
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BOM dialogue window

Delete symbol at cursor

For various Delete functions a symbol was shown at the cursor in previous versions. This is no longer the case.

Insert part - Now also for .PAA archives

The functions Insert part, via Explorer and Insert part, via HELiOS document master/article master now
also allow the insertion of parts from .PAA archives, which are , for instance, used in Plant Engineering.

If a .PAA archive contains different representations, these will be offered for selection before insertion takes place.

The insertion from a .PAA file via HELiOS takes place for pipe parts via the Combined search and the link AllgTyp-
Geometrie (GeneralType-Geometry), for all other parts via the link Bauteil-Teilegeometrie (Part-Part geometry).
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Major Release 2016 (V 2100)

Start HiCAD

The News window

In order that you can take full advantage of the numerous new features and enhancements offered by HiCAD 2016,
check out the videos explaining the new and changed HiCAD functionalities. From now on we will provide you with
such videos with eachMajor Release and Service Pack to keep you constantly informed in the best possible way.

You can configure the display of the News window at the bottom left. We recommend using the Show most recent
news option to ensure that you will never miss any news about HiCAD. You can call the News window again at any
time and change the display option by clicking on the “?” symbol at the top right and selecting Show news.

Please note:

To suppress the 'News' window on the Client computers in the case of a use on a network (i.e. to achieve a beha-
viour as if the user had chosen Never show him-/herself), the Administrator must copy the file HiCADNews.Set-
tings.XML to the

%APPDATA%/ISD Software und Systeme\HiCAD 2016\GUI\News

directory of the Client computers. In line 4 of the XML file, the Value needs to be set to 2:
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Load/Save

Redesigned dialogue windows

The HiCAD dialogues for the loading and saving of files have been adapted to Microsoft Windows 10 standards. For
example, frequently required folders can now be stored beneath a Quick access item in the structure tree of the
browser.

The Open dialogue window

Progress bar during loading and saving

The progress bar that is shown during the loading of drawings has been improved and is now displayed con-
tinuously. This also applies to the loading of large 3-D parts (.KRA).

If referenced parts need to be updated when loading drawings, the progress bar will be stopped. After suc-
cessful updating, it will be continued.

HELiOS terminology and dialogue window

Terminological changes

As of HELiOS Version 2016 (2100.0), HELiOS "Parts" will be called Articles, the former "Part master" will be renamed
to Article master and the former "Part attributes" to Article attributes. These changes also required some
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adjustments of function names and dialogue texts in HiCAD, e.g. when opening, or saving drawings via the HELiOS
database.

Please also note that parts in HiCAD will continue to be called Parts. Only through their management in HELiOS will
they become Articles.

Some other terms have been changed as well. You can inform yourself aboiut these changed in the "What's New"
topic (News) of the HELiOS Online Help.

Integration of the new HELiOS masks

The current data input and search masks of HELiOS have been integrated into HiCAD. As a result, the HiCAD-
HELiOS interface will benefit from the significantly greater functional range of the new masks and result lists.

Coordinate systems

Coordinate system display

The previous functions for the display and representation of coordinate systems have been combined into the new

CS display

function.

Specify via the radio buttons whether the coordinate system is to be displayed in all views or only in the active view.
Specify whether this setting is to apply only to the Model area or to the Model and sheet area by activating or deac-
tivating the Only in Model area checkbox . If the checkbox is activated, no coordinate systems will be displayed in
the Sheet area (irrespective of the chosen radio button).

The Length of axes value determines the size of the coordinate system display. The value must be greater than 0.

The coordinate system display will be saved when you close HiCAD. This means that if the display is active when
HiCAD is closed, it will still be active when HiCAD is started the next time.

Please note:

n The CS display function does not refer to this coordinate system that can be hidden and shown via F3, but to the
coordinate system that is displayed by default in the origin (0,0,0) of each view.

n The representation as space cube is no longer available.
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Fitting coordinate systems

The behaviour of fitting coordinate systems has changed.

n A part can only have one fitting coordinate system. If you have defined several fitting coordinate systems in a
row, the last defined fitting coordinate system will be used and saved to the base data. This rule also applies if
several entries for fitting coordinate systems exist in the feature log of the corresponding part.
This behaviour also applies for legacy data from older HiCAD Versions (before 2002.2)!

n If a fitting coordinate system has been defined for a part several times, and the Delete Fitting CS... func-
tion is then applied to this part, the previously defined fitting coordinate systems will still be shown in the feature
log. After a recalculation, the last but one fitting coordinate system will apply.

n If the base data of a part (from HiCAD versions before 2100.0) contains several fitting coordinate systems, the
last defined fitting coordinate system will apply here, too.

ICN

New symbol for standard part groups

The symbol for 3-D standard part groups in the ICN part structure has been changed.

Standard part groups are now identified by the symbol.
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2-D

Service Pack 1 2016 (V 2101)

Itemise part
The dialogue window of the Itemize part function has been redesigned.

The functions that could previously be found in the lower area of the Item number dialogue window can now be
found in the pull-downmenu of the Item. function in the Text function group, or in the context menu of an item
number.

When you choose the options Prompt for item number and Generate item number, a warning icon will be
displayed. If youmove the cursor over the icon, the following warning message will be shown:

This function assigns item numbers without checking for possible conflicts; i.e. conflicts with other items will not be
recognized, so that different item numbers may be assigned to identical parts!

2-D
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3-D

Service Pack 2 2016 (V 2102)

Simulations

Polyline motor with reference point

Without an explicit reference point specification, Polyline motors will always start at the start or end point of the poly-
line, and will calculate transformations in such a way as if the part to be moved was located in this position. If the
part to be moved is located far away from this start point, the part will perform an unexpectedmovement.

Similar problems occur when the part is to start right in the middle of an edge. In this situation, it is located far away
from the start point and end point of the edge, thus causing unexpectedmovements.

Such problems can be avoided by specifying a suitable reference point on the part. This reference point will be pro-
jected onto the polyline. The Polyline motor will then calculate the transformations relative to this point on the poly-
line, and no longer relative to the formerly chosen start point.

Click here to view an example.

Standard Parts / Standard Processings

Interaction of CADKLICK with HiCAD

The ISD Group cooperates with the company KiM GmbH (http://www.cadclick.com/). Parts in supplier catalogues,
e.g. HILTI dowels, can now directly be inserted in HiCAD via the CAD click solutions.

Extensive information can be found in the Help for Interfaces.

Bore patterns based on sketches

The shape of bore patterns is stored in the Factory standards catalogue. In addition to the previously used 2-D
HCM variants (.DCF) you can now also use planar sketches saved as 3-D parts (.KRA).

Change weld seam numbers

The Change weld seam number dialogue window has had a redesign.
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Weld symbols - Improved display for colour selection

When inserting or editing weld symbols, longer colour names were simply cut off in the dialogue window. As of SP2
the following procedure applies:

n The colour name in the selection field will be abbreviated.

n When youmove the cursor over the colour selection field, the complete colour name will be shown in a tooltip.

Copy Standard Processings

The Copy Standard Processing function is now also available in the context menu for Standard Processings.

Boltings/Rivetings

Boltings and Rivetings can now also be inserted repeatedly. This means that the New bolting/riveting func-
tion will not be ended automatically after insertion, but remains active, allowing you to insert further boltings or riv-
etings with the same settings (processing plane, bolting assignment, clamping length etc.). What can be modified,
though, is the grid used for insertion.
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Sketches

Move points

The two functions

n Move points and

n Move points, in rectangle

at Sketch > Transform have been combined into one new function, MovePts . The old Move point function

(previously to be found at Sketch > Process > Trim > Polyline) has also been withdrawn.

You use the new MovePts function to move one or several points and lines of a sketch. Basically, the pro-
cedure is very similar to that of the Move, Preserve connected lines and adjust length function for sketch elements.
The difference here is that not only isolated points but also individual start or end points of the sketch elements can
be moved, and that the preserving of connected lines does not take place here via length adjustments, but is based
on the logic of the HCM dragger. In the process, HiCAD will try to preserve the HCM constraints where possible.
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In Case A the original sketch (1) has been processes with the MovePts function; in Case B, the Move, Preserve con-
nected lines and adjust length option has been chosen. In both cases the elements have been chosen via a rect-
angle (2), and the same direction (3) and the same distance has been chosen. (4) shows the results.

Transform / clone sketches

When transforming or cloning sketches, the Distance input fields will be locked as long as no displacement dir-
ection has been chosen. This concerns the following functions:

n Move sketch elements

n Move + Rotate sketch elements

n Clone + Move sketch elements

n Clone, Move + Rotate sketch elements

Scale sketch elements

The effect of the middle mouse button has also changed. This concerns the following functions:

n Scale sketch elements

n Clone + Scale sketch elements

When youmiddle-click on the drawing while the dialogue window is open, the following will happen:

n If you have made sufficient value inputs (at least specify length and fixed point), the function will be executed.
The dialogue window will remain open afterwards. (same as with the Apply button).

n If the value inputs are insufficient, HiCAD will jump to the next required selection. For instance, if you have
chosen the line to be scaled and then press the middle mouse button, HiCAD will jump to the selection of the
fixed point. If you press the middle mouse button again after the fixed point selection, the function will be
executed - even without a direction selection.

Trim sketch elements

The dialogue window for the function Sketch > Process > Trim... has beenmodernized.

When youmove the cursor over the sketch in your drawing, HiCAD will check, depending on the current cursor pos-
ition, whether the sketch element has any intersection points with other sketch elements. If this is the case, the por-
tion of the element that would be deleted will be highlighted in a different colour (magenta, Special colour Marking
1). The portions of the element that would be preserved as well as their end points will also be highlighted (Special
colour Preview). The end points will be represented as small spheres.

Click to perform the deletion.
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Example (Sketch)

The handling of HCM constraints, too, has been improved.

Divide sketches

The Divide line, via number of segments function has been enhanced:

n The Convert to lines checkbox now only affects curves. As a result, HCM constraints on straight lines will be pre-
served.

n In the context menu, the functions All lines and All curves have been renamed to Connected lines (only
straight lines) and Connected lines (only curves), respectively.

Convert 2-D splines to sketches

Sketch > New > Convert 2-D part to sketch function now also considers and correctly converts 2-D splines
that are, for example, created during 2-D DXF import.

Assemblies

Form assemblies

When forming assemblies from already existing parts, HiCAD will now automatically display the Part attributes dia-
logue window after the creation of the assembly. In this way, the attributes of the assembly can be determined
immediately.

Right-click a part to choose the Form assembly function in the context menu.
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Views

Shortened views

If a view shortening is not possible, e.g. because of a currently active, shaded OpenGL view, an appropriate mes-
sage will be displayed. You have then the option to choose how to proceed further. The corresponding dialogue win-
dow has been adjusted in SP2.

Change sectional view identifiers

If you choose the Change sectional view identifier, All function in a model drawing that contains views with dif-
ferent identifier settings, this will be indicated in the corresponding input fields by the text <Different values>.

If you enter a value into one of those fields and confirm with OK, the entered value will be applied to all identifiers. If
you enter no value and confirm with OK, the different values for the sectional view identifiers will be preserved.
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Overlapped edges in HiddenLine views

The representation of edges in HiddenLine views has been improved. For example, previous issues with centre
lines, crosshairs and symmetry lines have been resolved, so that part edges are no longer overlapped by crosshairs
etc.

Process parts

Clone processings

n The 2 new cloning pattern types "Polyline pattern" and "Translatory and rotatory pattern" have been added to the

Clone processings function. This allows you to define clonings along polylines and composite edges, or
combined rotatory and translatory clonings.

Example of the cloning of a subtraction along a polyline

n Besides the definition of omissions in a table you have now also the option to select them intuitively by identi-
fying the clones to be omitted in the sketch.

Clean up intersections

The calculation time for the cleaning up of intersections could be reduced significantly. In test examples, time sav-
ings between 30% and 50% could be achieved.

Please note that the number of selected surface has a significant influence on the calculation time. This means
that, for instance, in thin-walled 3-D parts (e.g. hollow cylinders) the accuracy will not be decreased if only one sur-
face (inside or outside) will be selected.
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Chamfer

Since Version 2014, HiCAD has used a new algorithm for Boolean operations offering significantly enhanced sta-
bility - most notably for legacy data conversion or foreign data imports. This algorithm is now also applied for addi-
tions and subtractions or the chamfering of parts.

Select cylinder/cone axis as direction

You can select a lateral surface of a cylinder or cone to select the cylinder/cone axis. The direction will be determ-
ined by the current cursor position.

This concerns the following functions:

3-D-Standard > Process > Wall > Envelope

3-D-Standard > Process > Clone processings...

Sketch > Transform > Move...

Sketch > Transform > Rotate

Sketch > Transform > Mirror...

Sketch > Clone > Move...

Sketch > Clone > Rotate

Sketch > Clone > Mirror...

Sketch > Draw > Freehand > Transition curve

Referencing

Settings Update, Position - Dialogue

The dialogue window of the Settings Update, Position function in the Referencing menu has had a redesign.
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Processing of locked parts

Normally, the processing of locked parts (locked referenced parts or parts with "released" status) will be prevented
by HELiOS. In (very rare) cases in which a function will not prevent the processing of locked parts, a warning mes-
sage will be displayed, telling you that you have processed referenced parts for which you have no write per-
missions due to the lock. In such cases HiCAD will attempt to revert your changes automatically. This is, however,
only possible if the KRA file exists. In any case an appropriate message will be displayed, telling you whether the
reverting of the changes was successful or not.

Service Pack 1 2016 (V 2101)

Bores

Selection of centre of bores through cylinders

Centres of bores through cylinders or in arbitrarily curved surfaces can now be snapped with the Autopilot.

Referencing

Fitting CS of referenced parts

A so-called Fitting coordinate system (short: Fitting CS) is automatically assigned to 3-D parts when they are ref-
erenced, and entered into the feature log. Fitting coordinate systems that may already exist at the moment of ref-
erencing will be deleted.
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Proceed as follows:

n If a part is referenced directly upon its creation (which is, for example, possible for Solid primitives), its Fitting CS
will be the current local coordinate system. If no local coordinate system is defined, the Fitting CS will be determ-
ined by the points (0,0,0), (1,0,0) and (0,1,0).

n If a part is inserted, and referenced directly after its insertion, its coordinate system will be the World coordinate
system.

n If a part is inserted, and further parts are added to the drawing, and for one of these parts a local coordinate sys-
tem drawing is created, this local coordinate system will become the Fitting coordinate system when the first
part is referenced. This rule also applies if the referencing of the first part is removed and the part is then re-ref-
erenced.

Handling of article masters for referenced parts and assemblies

If a main assembly is referenced and has an article master which is different from the article master of the drawing,
no automatic corrections will be applied to the article master assignment and/or the HELiOS links of the main
assembly.

If the main part has an article master which is different from the article master of the drawing, no document master
links will be checked or corrected (this also applies to the Management + BIM functions). If the main part is also ref-
erenced, no article master links will be checked or corrected either (this also applies to the Management + BIM
functions).

Dependent parts - Load part

In previous versions it was not possible to activate the feature function "Load" for dependent parts based on a ref-
erenced parts (or variant parts managed by HELiOS) if the referenced part (or the variant part) was a read-only part.
As of HiCAD 2016 SP1 is is also possible to load locked/read-only base parts.
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3-D Dimensioning + Text

Itemize part

The Item number dialogue window has been optimized.

Please note that no check for conflicts will take place when you have activated the options Prompt fpr item num-
ber and Generate item number. Possible conflicts with other items will not be detected, and identical parts may
have different item numbers as a result.

Therefore, a warning symbol will be shown when you have chosen one of these options. Click on the symbol to
read the warning message:
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Warning message

The functions that were previously available beneath Edit and Delete are no longer available, with the exception of
the following functions:

Increment range of numbers

Align horizontally

Algn vertically

Click beneath Item... to open the pull-downmenu containing these functions.

Process parts

Exchange 3-D part

When using the Drawing > Insert Part > Exchange function in previous HiCAD versions, the Parts CS was
used for the original parts and the replacement part. As of HiCAD 2016 SP1, an existing Fitting CS will take priority
over the Part CS.

If for one of the selected parts or both parts a Fitting CS has been defined, not the Part CS, but the Fitting CS will be
used. This applies to the insertion of the replacement part (use of Fitting CS of replacement part) as well as to the
placing in the drawing (use of Fitting CS of original part).

The image below shows 3 different cases:
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A (1) Original part has no Fitting CS.

(2) Replacement part has a Fitting CS.

(3) Result after exchange.

B (1) Original part has a Fitting CS.

(2) Replacement part has no Fitting CS.

(3) Result after exchange.

C (1) Original part has a Fitting CS.

(2) Replacement part has a Fitting CS.

(3) Result after exchange.

In all cases, the origin (right-click) has been selected as the fitting point.
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Aligning of Steel Engineering plates

The functions beneath Alignment of derived drawings in the context menu for parts:

n Active view as front view and

n Active view as top view

can now also be applied to Steel Engineering plates. This allows you to specify the alignment of plates in Workshop
drawings.

Line types of 3-D parts

n For all 3-D parts to which an edge colour can be assigned, the context menu now contains the Line type

function. This function can also be found at 3-D Standard > Tools > Attr. > Properties....

n The line type can be assigned to all views, or only to the currently active view.

Context menu for parts

n The function can also be applied to multiple selections.
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Views

Settings/configuration for views

The "Automatic ViewAll" parameter in the Configuration Editor has been renamed to Automatic ViewAll after pro-
jection change.

The dialogue text have also beenmodified.

Use the parameter Automatic ViewAll after projection change to specify when the ViewAll representation is to be
applied automatically:

n Never
ViewAll will not be activated automatically. An exception are the functions 4 standard views and 6 standard
views. Here, ViewAll will always be activated automatically.

n After calling a standard projection
ViewAll will automatically be activated when you call a standard projection. This applies to:

l Front, side and top view, and bottom view, rear view,

l Axonometries,

l Isometries and

l Active XY-plane in screen plane

n Also after step-by-step rotation
ViewAll will also be automatically activated after a step-by-step rotation. This is the default setting.

Create/process sketches

Creation of spirals

The creation of spirals has been optimized in such a way that, while space requirements remain unchanged, a con-
siderably higher precision can be achieved. This applies only to spirals with constant radius and constant lead.

Transform/Clone dialogues

The dialogue windows for Sketch > Transform and Sketch > Clone have changed as follows:

n The term Number has been replaced with the term Clones. This concerns all Sketch > Clone functions. This
means that the actual number of clones must be entered in the dialogue now, the original is no longer included.

n The term Length has been replaced with the term Distance. This concerns the following functions:

l Sketch > Transform > Move

l Sketch > Transform > Rotate > Move + Rotate

l Sketch > Clone > Move

l Sketch > Clone > Rotate > Move + Rotate.

n The text Distribute evenly across length has been changed to Total distance, the text Distribute evenly across
angle has been changed to Total angle. This concerns the following functions:

l Sketch > Clone > Move

l Sketch > Clone > Rotate

Furthermore, the Sketch > Clone > Rotate function now offers the additional selection option Evenly, 360° that
enables you to distribute original and clones with even distances along a full circle.
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n When you select a direction, the text Displacement direction in the input field has been replaced with the text Dir-
ection angezeigt. This concerns the following functions:

l Sketch > Transform > Move

l Sketch > Transform > Rotate > Move + Rotate

l Sketch > Transform > Scale

l Sketch > Clone > Move

l Sketch > Clone > Rotate > Move + Rotate.

l Sketch > Clone > Scale

Transform - New option

The Transform functions for sketches now allow you to specify the handling of connected lines during line trans-
formations.

Scale lines, individually

If this option is active, only the actually selected lines (highlighted red) will be scaled. Connected
lines will not be adjusted.

Preserve connected lines and adjust length

If this option is active, HiCAD will attempt to preserve the position of the connected lines if possible.
In the process, the length of the lines to be scaledmay be adjusted by means of new intersections.
For distances the angle between connected lines will be preserved.

Close polyline

The "Close c-edge, with line" function has been renamed to Close polyline . Also, the dialogue window of the
function has had a redesign.

n Move the cursor near an edge of the polyline you want to close. If a closing of the polyline is possible, a preview
image will be displayed.

n Apply the connection with a left-click. The function remains active, i.e. you can close further polylines if desired.
Press the middle mouse button to exit the function.

n Right-click to open a context menu.

n Polylines of non-active sketches can also be closed with this function. The created new connecting lines always
belong to the processed sketch.

n You can use UNDO to revoke your last action.

Divide line

The Divide, Number function has been enhanced. ist erweitert worden. If you want to convert the segments
to lines, activate the new Convert to lines checkbox:
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The context menu of the function offers the following new functions:
All lines

Divides all lines of a polyline. Curves will not be considered.

All curves

Divides all curves of a polyline. Lines will not be considered.

The following functions are no longer available:

n Divide polyline, All lines

n Divide c-edge, All curves and

n Divide c-edge, All edges.

Change purpose

The purpose of planar sketches can now be changed. To do this, select Sketch > Tools > Sort GE >
Change purpose.

Weld seams

Settings for Insert new weld seam / Insert weld symbol functions

The last specified settings for the

n Insert new weld seam and

n Insert weld symbol

functions will be the new default settings (also after a restart of HiCAD).

Variants

Variables names in variants

The maximum length of variables names has been increased from 4 to 255 possible characters.
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Other new features and enhancements

Adding of 3-D parts to Steel Engineering parts

The adding of 3-D parts to a Steel Engineering parts may cause problems with subsequently called functions, e.g.
mitre cuts, Steel Engineering connections, NC/NCX export, deriving of drawings, etc. Attributes (e.g. weight,
length, etc.) may also be calculated incorrectly. In such cases, HiCAD will display the following warning message

after selecting 3-D-Standard > Process > Add function :

You can then decide whether you want to execute the function or not.

If you do no longer want this message to be displayed, activate the Suppress message checkbox. In this case, the
adding will either be accepted or refused, depending on your last choice in the message window.

Please remember that the checkbox status applies only to the current HiCAD session!
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Major Release 2016 (V 2100)

Performance

HiddenLine representation

The HiddenLine calculation could be speeded up significantly - in various test drawings, speed increases between
20% and 80% could be achieved.

Changed '3-D Standard' Ribbon

Clone processings/feature

Use the new Clone processings function to copy existing features onto other surfaces. If the same feature
steps are required in several places of a part, this function can help you to save a lot of time. You can find the func-
tion at 3-D Standard > Process and in the Feature context menu, where it is called Clone feature.

Extensive information on this function can be found in the Feature Technology Help.

Add/Subtract

n The Subtract, via rotation function can now be found in the pull-down-menu of the Subt. func-
tion.

n The Add, via rotation function can now be found in the pull-downmenu of the Add function.

Views - Settings and editing

Settings for views (ANSGEN.DAT)

The settings for views, which were previously specified in the system file ANSGEN.DAT have be transferred to the
Configuration Editor. You can now find these setting options at

n Drawing > Views

n System settings > Visualisation

n System settings > Visualisation > Views

n System settings > Visualisation > View group

Here, you can now separately specify the settings for sectional and detail views, and also specify the settings for
the representation (colour, line type and layer) of the frames for view groups for drawing derivations.
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Please also read the News for the Configuration Editor.

Sorting and numbering of sheet areas

Sheet areas can now be sorted and re-numbered.

The display order of the Sheet areas can be changed conveniently via Drag & Drop. You can move individual Sheet
areas as well as several Sheet areas in one step.

Individual Sheet areas, but also multiple selections of Sheet areas can be re-numbered. The first number is freely
selectable. The other numbers will be assigned consecutively, in the display order of the Sheet areas.

Also new is the Sort, ascending function that allows you to sort the the Sheet areas by Sheet numbers in ascending
order, e.g. after changing of Sheet numbers or after Drag & Drop actions.

The display order of the Sheet areas will be saved together with the drawing.
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Enhanced options for sectional/detail views

For the definition of sectional and detail views you can now also specify the text and line parameters of the view
identifiers.

For this purpose, the following options are available in the dialogue window of each function:

n Change text and line parameters (sectional view) and

n Change text and line parameters (detail view)

The default setting of these parameters can be specified in the Configuration Editor, at Drawing > Views > Ident.

Text and line parameters for sectional view (left) and detail views (right)

To change all identifiers in a sectional view or detail view, use the functions

n Change sectional view identifier, All, and

n Change detail view identifier, All.

You can find these function in the pull-downmenus Views> Edit > Section or Detail .
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Structure and Properties

Delete main part identifier

In the context menu of 3-D parts you will find the new Delete main part identifier in the sub-menu of
Part/Assembly structure.

Use this function to delete the identifier of an assembly main part. . The part will become a "normal" part and the
identifier will be removed. This function makes sense in welded Steel Engineering assemblies, where you want to
remove the identifier of an assembly main part that was created in the welded assembly.

Line type of 3-D solids

Use the Line type function to assign a line type to 3-D parts of the type "Solid". To call the function, right-click
the 3-D part and select Properties > Line type.

In this way, you can, for instance, display the contour edges of neighbouring parts by dash-dotted lines, as is quite
common according to certain standards.

Select line type
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Please note:

n The setting takes only effect in HiddenLine and Glass model representations.

n The selected line type also applies to highlighted edges.

n In connection with this function, the settings for referenced parts in the Configuration Editor have been revised.
There you can specify at System settings > Referencing, separately for colour,line type and layer, whether
these parameters are to be updated when loading referenced parts.

3-D dimensioning

Dimensioning symbols

When placing dimensioning symbols with the functions available at 3-D Dimensioning + Text > Edit > Sym-
bols... and during editing of dimension figures the additional

ⒺEnvelope condition

symbol according to DIN EN ISO 8015 (Envelope conditions for fits) is now available.

Standard Parts and Boltings

Insert weld seams

The function of the Apply button has been changed. When you now click this button, the weld seam will be created
with the specified parameters. After creation of the tag the Weld seam function will remain active, and the selec-
tion of parts to be welded will be requested repeatedly.

Process weld seams

n The dialogue for weld seam creation can now also be opened by double-clicking the Weld feature.
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Spring connectors

When inserting spring connectors you can now also select the edge of the bore instead of the insertion point.

Bolting settings - New 'Bolt assignment' options

The settings dialogue for boltings now offers a number of new Bolt assignment options:

The new functions enable you to bolt parts together that are located in locked assemblies.

Derive/edit sketches

Purposes of planar sketches

HiCAD automatically assigns a purpose to planar sketches upon their creation. One distinguishes between

n Purpose = Part

n Purpose = Create/Edit

Sketches with the purpose Create/Edit are, in principle, "auxiliary elements" from which other parts, processings
and sectional views, detail views or cut-outs. Sketches with this purpose are visualized with broader lines in the act-
ive view. They are also visible in shadedmodels.

Sketches with the purpose Part are regarded as "normal" parts that are used as elements of the drawing. They dis-
tinguish themselves from sketches with the purpose Create/Edit as follows:

n In cut-outs, sectional views and detail views the sketch will be cut.

n The sketches have no special representation and are not shown in shadedmodels (without edges).

n The sketch can be edited with the functions available at 3-D-Standard > Tools > Crossh., i.e. it may contain
centre lines, crosshairs etc.

When a new sketch is created, HiCAD automatically determines its purpose. For example, sketches that are cre-
ated in connection with View functions, during deriving of new 3-D parts from a sketch, during processing of 3-D
parts with sketches etc. will obtain the purpose Create/Edit.

In contrast, if a sketch is created with the functions of the Sketch tab, the purpose specified in the Configuration
Editor will be assigned. The default setting is Create/Edit. This default setting can be changed in the Configuration
Editor, at System settings > Sketches.
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Purpose for new sketches / new sketches in Metal Engineering grid

This setting determines which purpose will be assigned when a sketch is explicitly created with the functions of the
Sketch tab (default: Always Create/Edit). The alternatives are Always part and Always query. If the setting Always
query is used, you will be asked to specify the purpose whenever you create a new sketch. For sketches which
have been created via the Metal Engineering plugin the setting setting Always query is not available.

Sketch representation for...

This setting concerns sketches that are created during definition of sectional views, detail views and cut-outs.
These sketches can either be shown in all views (default) or only in the active view.

Subsequent changing of the purpose

To change the purpose of a sketch, right-click the sketch either in the drawing or in the ICN and select Further >

Change purpose .

Fillet/chamfer sketches

You can now also use the functions Sketch > Process > Fillet and Sketch > Process > Chamfer to pro-
cess corners of non-active sketches or 3-D sketches. Please note however that HCM constraints that cannot be
kept to will be deleted.

An exception is the selection of corners via selection rectangle. Here, only elements of the active sketch
will be considered.

Behavious of the middle mouse button

The behavious of the middle mouse button has changed with regard to various functions. If you middle-click in the
drawing while the dialogue window is displayed, the following will happen:

n If enough inputs have beenmade, the function will be executed. The dialogue window will remain open (cor-
responds to the Apply option).

n If not enough inputs have beenmade, the function will be ended.
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This behaviour applies to the following Sketch functions:

Offset with end caps

Fillet

Chamfer

Divisde, Via number of segments

Lenghten line, by value

The Lengthen line, by value function has had a complete redesign. Graphical elements, i.e. straight lines and
arcs of a sketch, can ow not only be lengthened/shortened by a particular value, but also by specifying a new total
length.

When you move the cursor over the lines of a sketch while the dialogue window is open, a dynamic preview of the
lengthening or shortening will be displayed.

Also new is that HCM constraints will be considered by this function.

3-D
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Sketches - Projection with automatic clean up of overlaps

n Conic section edges (circles, ellipses, hyperbolas,parabolas) the planes of which contain the projection dir-
ection, often produce overlaps in the projection. HiCAD automatically recognizes and cleans up such situations
in vertical and directed projections, by replacing such edges with straight line segments. The same applies to
NURBS curves in such planes.

(1) Active sketch; (2) Selected conic section; (3) Projected straight line segment

Transform/Clone sketches

The Transform and Clone functions for graphical elements of planar sketches have been redesigned.

For example, the Move, Rotate, Mirror and Scale functions for graphical elements have been combined into one
central function that can be used for planar sketches and 3-D sketches. The same applies to the Clone functions.

The old functions in the pull-down menus are not available any more, since the new functions cover almost all spe-
cial cases. Exceptions are the functions Similarity, Affinity andMove+Rotate, which are no longer there.

The Undo/Redo functions for sketch transformations have been withdrawn as well. To revoke transformations of
sketch elements, you use the general Undo function now. To apply the last performed transformation to other
sketch elements, use the Apply button of the function dialogues.

Example: New Rotate dialogue window
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In all functions, the selected elements, the displacement directions, the rotation axis etc. will be visualized dynam-
ically, and a graphical preview of the transformation will be displayed.

Simplify parts

Delete superordinate parts

Sometimes, a part structure contains levels and dummy parts that are bothersome during simplification. Use the

new Delete superordinate parts function to solve this problem. You can find the function on the Simplify tab.

This function deletes all "superordinate parts" in the part structure. This means that all parts that are only there for
the sake of structuring will be removed and the remaining parts will be shifted to the uppermost level of the part
structure. Main assemblies, assemblies and dummy parts will be deleted, their sub-parts will be preserved. Assem-
blies and dummy parts without sub-parts will also be deleted.

Merge all solid

Use the new Merge all solids function to merge all parts of the type "Solid" that belong to a part list (multiple
selection) to
one new solid by means of a Boolean operation. Proceed as follows:

n Define the part list, e.g. using the context menu functions in the ICN or the part filters.

n Call the Merge all solids function.

n Specify whether the original solids are to be retained or deleted after merging

3-D
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Envelope with sketch processing

When using the Envelope function in connection with the Translation option you can now, for each of
the three defined directions, process the sketch on which the corresponding extruded envelope is based, without
having to exit the function. For this to happen, you first need to click the Preview button.

Click the Manual/Automatic radio button for the corresponding direction, and then, click the Process sketch

symbol. The corresponding sketch and the following dialogue window will be displayed:

You can now process the sketch with the Sketch functions. After completion of the processing, confirm with Apply
sketch. The envelopoe will then be adjusted accordingly.
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Example - (1) Original part; (2) Extruded envelope; (3) Sketch to be processed

Surface and Edge functions

Copy / Take surface - not for assemblies

For the functions Copy surface and Take surface assemblies are
not allowed as target.

3-D
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Insert edges - not for assemblies

Free edges cannot be inserted into assemblies andmain assemblies.
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Catalogue Editor

Service Pack 2 2016 (V 2102)

New system attribute: Order number
In the System Settings catalogue a new attribute is now available in the System attributestable:

Order number (Attribute name $ON)

This attribute will, for instance, obtain a value when you directly insert parts (e.g. of the company HILTI) via elec-
tronic part catalogues which have been realized through solutions by CADClick.

"Filler plate" usage
At Factory standards> Usage > Civil Engineering > Steel Engineering you can now find the new Filler plate usage
in the Plate type table.

This usage will be automatically assigned to filler plates upon insertion of the corresponding Steel Engineering con-
nections.

Composite panels as semi-finished products
Composite panels are now available as Sheet Metal semi-finished products at Factory standards > Sheets > Com-
posite panels. These composite panels consist of two 0,5 mm aluminium cover sheets with a mineral core. In
HiCAD the plate is represented simplified as a one-layer sheet. Since the weight calculation is done based on a
homogeneous material, an ownmaterial is assigned to the pane.

New column for multiple tables
At Extras > Catalogue you will now find the new New column for several tables function, that allows the adding of
a new column to multiple (or all) tables of a catalogue in one step.

To do this, activate the desired catalogue and call the function.

In the displayed dialogue window, specify the properties of the new column on the right. On the left, all tables
belonging to the catalogue are listed. Click to select the tables to which to want to assign a new column. Multiple
selections in one step are possible by simultaneously holding down the CTRL or SHIFT key. As soon as you close
the window with Apply, all selected tables will be processed.

Catalogue Editor
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RAL colours
The RAL colours in HiCAD were previously defined in the system file RALRGB.DAT. As of SP2, the RAL colours are
defined in the RAL CLASSIC table. You can find this table in the Catalogue Editor at Textures and Colours > Col-
ours.

CUSTOM columns
For fasteners the further CUSTOM columns CUSTOM6 - CUSTOM9 are now available, allowing you to assign cus-
tomer-specific data to fasteners. For instance, this provides access to HELiOS attributes which are not of the type
STRING.

Column Attribute Data type

CUSTOM6 free Integer

CUSTOM7 free Integer

CUSTOM8 free Floating point

CUSTOM9 free Floating point

The columns have the initial value 0.

Service Pack 1 2016 (V 2101)

New studs ans washers acc. to DIN EN ISO 13918
The catalogues for fasteners of the type Studs andWashers acc. to DIN EN ISO 13918 have been expanded.
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n In the catalogue Fasteners> Washers > Ceramic rings you can now find

l Ceramic rings of the type PF, RF and UF.

n In the catalogue Fasteners > Studs > Welded studs you can now find the following new studs:

l Welded studs of the type ID, IS and IT

l Welded studs of the type UD, US and UT

l Threaded welded studs of the type RD, PD, PS and PT

Pipes acc. to DIN 10305
New in the Semi-finished products > Beams + Profiles > Steel pipes catalogue are pipes acc. to DIN 10305:

n 10305-1 Seamless cold-drawn pipes

n 10305-2Welded cold-drawn pipes

n 10305-3Welded custom rolled pipes

n 10305-4 Seamless cold-drawn pipes for hydraulics and pneumatics

n 10305-5Welded custom rolled pipes with quadratic and square cross-section
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Checking of catalogue directory upon HiCAD start

It will now be checked to which HiCAD version the catalogue directory belongs. The version is shown in the caption
of the dialogue window of the Catalogue Editor. When performing an update with the CatalogueUpdate.exe tool, the
corresponding HiCAD version will be shown in the dialogue window of the tool.

The version of the utilized catalogue directory will be checked upon HiCAD start. If the catalogue directories are old
there is a risk that HiCAD will search for catalogue entries which do not yet exist in the old catalogues. One
example of this are the Textures that were integrated in the catalogue some time ago. If these are missing in the
catalogue, you will have no access to these textures in HiCAD.

If you start HiCAD with an old catalogue directory (e.g. HiCAD 2100.1 with Catalogue 2100.0 or HiCAD 2100.0 with
Catalogue 2002.2), a corresponding message will be displayed:
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If the version of the catalogue cannot be detected, the following message will be displayed:
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Major Release 2016 (V 2100)

New bolts + screws
n New in the catalogue Fasteners > Bolts+Screws > Countersunk head bolts are hexagonal socket countersunk

head bolts acc. to DIN EN ISO 14582.

n The following bolts acc. to DIN EN 14399 are available:

l Countersunk head bolts acc. to DIN EN 14399-7

l Fitting screws acc. to DIN EN 14399-8

l Hexagonal head screw acc. to DIN EN 14399-10

l Pan head screws acc. to DIN EN 14399-10 button-head
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Feature Technology

Service Pack 2 2016 (V 2102)

Clone processing function - 2 new patterns
The 2 new cloning pattern types "Polyline pattern" and "Translatory and rotatory pattern" have been added to the
Clone processings dialogue window. This allows you to define clonings along polylines and composite edges, or
combined rotatory and translatory clonings.

Example of a subtraction along a c-edge

Easier definition of omissions for cloned features
In the Omissions area you can specify individual clonings that are to be omitted. To do this, click on the Select
omission button (1) and then identify individual omissions in the drawing (2).

Feature Technology
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Alternatively you can click Show table (3) button show the omissions in tabular form. One column per cloning pat-
tern will be shown, with one row representing one omission. Click on the "Plus" button to add further omission; right-
click a row and select Delete row to remove it again.

Message when loading files from a newer HiCAD version
As of Version 2102 HiCAD will check upon opening of files whether these contain an incompatible feature log. Such
situations may occur if the file was created with a newer HiCAD version.

In such cases a message will be displayed, warning you that if you save the file with your HiCAD version, the feature
log or part thereof will be lost.

Service Pack 1 2016 (V 2101)

Move multiple features
It is now possible to move several features in one step: Mark the features by clicking them while holding down the
CTRL or SHIFT key andmove them with Drag & Drop.

Additional 'Clone' options
The Clone processings function has been expanded: For linear patterns new options are available that enable a
using of reference lengths for distance specifications. The dialogue window has been enhanced as well, now offer-
ing a small sketch and a short description of the distance and angle options:
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You have now the option to define omissions in patterns, and to pick lengths and angles directly from the drawing.

Furthermore, you can now also clone other features: Appearance, Move edges, Crosshairs, Wrap, Fitting CS.

Recalculation of API variants after deletion of parts
Features created via API variants, such as stairs and railings, can now also be updated or modified after deletion of
parts that were created by these variants. However, these deleted parts will be re-created if they are required
according to the specified parameters or the geometrical situation.

Lists as new part type for formulae
You can now use Lists as a new data type. These lists contain one or several values, formulae, or further lists. They
can be used, for instance, as lists of omissions when working with the Clone processings functions.

Feature-compatible deletion of crosshairs
Automatically inserted (e.g. after insertion of a bore) and manually deleted crosshairs will now remain deleted after
feature recalculations and will not be restored automatically any more.

Longer variables names for variants
The previous limitation of variables names to not more than 4 characters does no longer exist.

Variables names can now consist of up to 255 characters.
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Major Release 2016 (V 2100)

Clone processings

The new Clone processings function allows you to apply one or several feature steps in the feature log
repeatedly. Both linear and rotatory pattern can be used for this.

Example: Creation of a gearwheel.

Create a disc-shaped plate as a Cylinder and extrude a tooth by means of a translatory movement.

When you call the function, the Clone processings dialogue window will be displayed.Select the centre axis of the
cylinder as the rotation axis. The clonings are to be distributed evenly about 360° (full circle), and 20 clones (copies)
are to be created:
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Result:
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Configuration Management

Service Pack 2 2016 (V 2102)

Settings of STB_PARAMETER.DAT moved to Configuration Editor
The Steel Engineering settings that were previously specified in the system file STB_PARAMETER.DAT have been
moved to the Configuration Editor. There, you can find the settings at Steel Engineering and Compatibility.

Therefore, the corresponding settings have also been removed from the Steel Eng. Settings dialogue window.

Settings of SSTINI.DAT and SSTINI3D.DAT moved to Configuration Editor
The settings of the files SSTINI.DAT and SSTINI3D.DAT are no longer relevant for HiCAD and are therefore no
longer available.

Rearranged Management + BIM settings in the Configuration Editor
The settings for Management + BIM have been rearranged. You can still find them at PDM > Management + BIM.

DSTV-NC parameters
The parameters at Steel Engineering > DSTV-NC

n Configuration of drawing number and

n Configuration of order number

have beenmoved to the export dialogue.

IFC attribute mapping
During the data transformation between IFC and HiCAD the attribute values from the original data will be trans-
ferred to permissible attribute values of the target system. The rules according to which the Attribute mapping con-
figuration is to be carried out can be defined for the import and the export of IFC files at Interfaces > IFC.

New Management + BIM settings

NCW format for part data

You have now the option to automatically create NCW data for part and to manage and link them in HELiOS.

A prerequisite for the creation of this file format is that the parameter Create NCW/NCX data at PDM > Man-
agement +BIM > External production drawing has been set to Yes. The default setting is No, i.e. no NCW data
are normally created.

Automatic creation of DWG files of production drawings during the workflow

You have now the option to automatically create DWG files for production drawings, either upon
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n Checkup and Release, or upon

n creation and updating

of the drawings. For this purpose, the settings at PDM > Management + BIM > External production drawings
have been expanded accordingly.

Clean up project

The new Clean up function (in the Project function group) cleans up the active project by detecting and deleting
invalid article masters.

Using this function only makes sense if the parameter Clean up project when saving at PDM > Management +
BIM has been set to No. The default setting is Yes, i.e. whenever you save your drawing, invalid article masters will
be removed automatically.

Hide boltings during drawing derivation
Boltings in production drawings can be hidden via appropriate settings in the Configuration Editor. You can specify
for each usage whether bolts are to be shown or hidden. The corresponding settings can be found at Automatic
drawing derivation > Production drawing > Usage-dependent > name > Views (with name being the name of the
respective usage).

Service Pack 1 2016 (V 2101)

Settings of PARAMASS.DAT file moved to Configuration Editor
The settings of the system file PARAMASS.DAT for parametric dimensions and the representation of HCM symbols
have beenmoved to the Configuration Editor. They can now be found at

n System settings > Dimensioning, 3-D > HCM dimensions

n System settings > Dimensioning, 3-D > Parametric dimension

The changes in the Configuration Editor will only take effect after a restart of HiCAD.

Handling of article masters when exchanging semi-finished products
The handling of manually assigned article masters when exchanging semi-finished materials can be defined in the
Configuration Editor at System settings > HELiOS - Handling of article master.

The collection of the Taking over of semi-finished product attributes parameter will be evaluated in the process.

Please note:

This parameter will not be considered for the exchanging of Sheet Metal parts via feature.

Taking over of semi-finished product attributes
At Taking over of semi-finished product attributes (System settings > HELiOS > ...) you can specify whether par-
ticular semi-finished product attributes are to be assigned to the manually assigned article attributes during
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exchanging of semi-finished products. Each assignment is defined in one row:

Semi-finished product attribute;Article attribute.

Configuration of views
The parameter Automatic ViewAll (System settings > Visualisation) has been renamed to Automatic ViewAll after
projection change. The dialogue texts have also been changed.

Scale-dependency of hatchings.
You can specify in HiCAD whether . The default setting is Scale- independent . With this setting, the spacing
between the hatching lines will always be the same, no matter which scale was selected.

The default setting shown in the dialogue window can be changed in the Configuration Editor, at System settings >
Visualisation > Scale dependent 3-D hatching.

PLMXML interface
The XML-based accompanying format PLMXML is a supplement to the JT interface. It allows the defining and stor-
ing of product structures and process data of complex assemblies in a readable form. Import and export options are
handled in the same way as in the JT interface.

Which export functions are to be activated or deactivated upon function call can be specified in the Configuration
Editor, at Interfaces > JT/PLMXML.
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Major Release 2016 (V 2100)

Settings of ANSGEN.DAT file moved to Configuration Editor
The settings of the file ANSGEN.DAT that contains setting options for views can now be found in the Configuration
Editor. There, the settings for views can now be found at:

n Drawing > Views

n System settings > Visualisation

n System settings > Processing plane

n System settings > Load/Save

n System settings > Sketches

n Compatibility

n Metal Engineering

New is the possibility to specify the settings separately for sectional and detail views, and that the representation
(colour, line type and layer) of view group frames can now be specified for derived drawings.

Expanded toolbar
The following functions have been added to the toolbar of the Configuration Editor:

Collapse all This function collapses the structure display of the Configuration Editor and shows only
the 1st level.

Expand 2
levels

Shows you the first 2 levels of the configuration structure.

Expand 3
levels

Shows you the first 3 levels of the configuration structure.

Expand all Expands the complete structure display of the Configuration Editor.
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Add new data record entry

In some areas you have the options to add new data records, or new groups with data records. To do this, click the
New group button, enter a name and click OK. The group will then be added and an empty data record entry will be
shown. When you now click on the input fields, you can compose the data record from the values in the displayed
selection boxes.

76 / 278 ISD Group - HiCAD 2016

ConfigurationManagement



Confirm your entries with Apply.

Use the New and Apply buttons to add data record also to already existing groups.

To remove a data record, mark it and click the Delete button. Click Apply to confirm the deletion.

Derived drawings
You now distinguish between Production drawing andMounting drawing. As a result, the tree structure has changed
here.

n The selection of the usage tow takes no longer place via a key, but via plain text.

n The assigning can be limited to particular part types. For example, if you want to assign the usage-dependent
setting STRINGER only to handrails of the type "Flat steel", select the same-named entry beneath Part type.

n The usages can be neatly arranged in groups. Predefined are the groups Railing, Metal Engineering, Steel Engin-
eering and Others.

n The creation of new assignments, and also the definition of new usage settings can take place directly ion the
list of assignments.

General view shortenings for derived drawings

At Automatic drawing derivation > Production drawing > Usage-dependent > …. > Views > Shortened view you
will find the new General view shortenings section. The settings will now be loaded from the Configuration Editor
not only for the views of beams and profiles, but also for other views, e.g. sheet views etc.
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Setting: Standard part annotation

In HiCAD 2015, standard parts were annotated if you explicitly activated the annotation of sub-parts or (as of SP1)
the annotation of boltings. As of HiCAD 2016 the annotation of standard parts can be switched on or off, inde-
pendent of other annotation types.

View groups - Frames, alignment, visualisation

A new listbox for frames and view groups offers the following selection options:

n Do not insert

n Always insert

n Insert, if there are multiple view groups

The default setting is Always insert. This presetting can be changed in the usage-dependent templates in the Con-
figuration Editor at: Automatisc drawing derivation > Production drawing > Usage- dependent > ... > View
groups > Frames around view groups.

If a drawing frame contains only one view group, it will be centred in the drawing frame. This behaviour, too, can be
changed in the Configuration Editor, at Automatic drawing derivation > Production drawing > Drawing > Centre
individual view group. If you deactivate the checkbox, individual view groups will be placed at the top left of the
drawing frame instead.

Colour, layer and line type of the frames can be specified in the Configuration Editor at System settings > Visu-
alisation > View group.

When creating drawing derivations, you can distinguish between "Mounting" and "Workshop" for semi-finished
products.

The relevant parameters can be found in the Configuration Editor, at PDM > Management+BIM > Individual part
type.

For production drawings you have now the option to create DXF and PDF files either

n during Checkup or Release, or

n during creation and updating

of the drawings. For this purpose, the Configuration Editor now offers additional setting options at PDM > VMan-
agement + BIM.

Automatic creation of DXF-/PDF files during a workflow

For production drawings you have now the option to create DXF and PDF files either

n during Checkup or Release, or

n during creation and updating

of the drawings. For this purpose, the Configuration Editor now offers additional setting options at PDM > Man-
agement + BIM.
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Line type for referenced parts
The presettings for part edge representation during loading of referenced parts in sectional views, detail views and
cut-outs have been changed. Colour, layer and line type can now be set at System settings > Referencing - Updat-
ing.

Hatching for rise triangles in Plant Engineering isometries
The settings of the vertical and the horizontal hatching angle are now calculated automatically for the sake of an
optimal visual representation. The previous input fields for manual settings have been removed. However, if you
prefer to use other hatching angles, you can still do this by specifying the desired angles in the Configuration Editor,
at Plant Engineering > Isometry and Pipe spool drawing - Dimensioning.

In Metal Engineering, a purpose will be automatically assigned to sketches. One distinguishes between Purpose =
Part and Purpose = Create /Edit.

In the Configuration Editor, at System settings > Sketches > Purpose for new sketches in ME grid (for a working
with the Metal Construction plugin) you can specify which of the two purposes is to be assigned when a new sketch
is created.

ConfigurationManagement

News Overview 79 / 278



Parametrics (HCM)
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Service Pack 2 2016 (V 2102)

Easier assigning of HCM constraints in Sketches
The assigning of HCM constraints has beenmade easier due to the following changes:

n When you set constraints of the type Symmetrical the symmetry axis will be queries only once. After this, you
can then directly choose geometry pairs which obtain the symmetry constraints.

n The same applies to the dimensional constraint Double distance.

n When you define positional and dimensional constraints, only geometries can be identified that actually make
sense for the chosen constraint. Example: A positional constraint of the type Mid-point can only be created
between two points or between two straight lines. If the first chosen geometry is a straight line, the second
chosen geometry cannot be a point.

Marking of reference geometries for particular point options
When you choose a constraint in the HCM window of the ICN that uses the point option Centre, the reference geo-
metry of this point will also be marked. In this way is becomes clearer to which element the dimensional constraint
refers.

For instance, in versions before HiCAD 2016 SP2 it was not obvious that the upper end of the distance constraint
refers to the centre point of the circular arc at the bottom right in the image below. From SP2 onwards, this point will
also be marked.

Left: Before HiCAD 2016 SP2; Right: As of HiCAD 2016 SP2

Service Pack 1 2016 (V 2101)

Improved dragging
Dragging in 3-D sketches has been improved. Besides individual lines and points, you can now also drag several
lines or complete polylines. Also, you can automatically create HCM constraints while dragging. Furthermore, drag-
ging is now muchmore convenient during working with freeform curves.
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Revised dialogue windows
For the Sketch HCM, the Automatic positional constraint and Automatic dimensional constraint dialogue windows
as well as their Settings have been revised.

For the 3-D Part HCM the Settings dialogue window has been revised.

The dialogue windows for automatic dimensional constraints, automatic positional constraints and the relevant set-
tings have been revised. They have been adjusted to the HiCAD layout and have now a clearer structure.

In addition, the 3-D C-edge HCM scaling dialogue window has had a redesign and now displays a small example
sketch illustrating the effects of the selected option.
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Major Release 2016 (V 2100) 

"Conditional" HCM constraints
HCM constraints can now, similar to Feature steps, activated or deactivated under certain conditions. For instance,
you can determine that a positional constraint of the type "Parallel" is only to be applied if an "Angle" variable is
greater than 75:

Further information on this function can be found in the The HCMModel in the ICN topic.

Support of further point options in the Assemblies HCM
In the Assemblies HCM you can now also use virtual points, created through the use of particular point options, for
the assigning of dimensional and positional constraints. These point options are:

n Mid-point of line/edge (M),

n Mid-point between 2 points (M2),

n Surface centroid (SP) and

n Body centroid (SK).

A prerequisite for this is that the points created by means of a point option are located on the same part. It is not
possible to create a distance constraint that points to the mid point between two points on two different parts.
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Bill of Materials / Report Manager

Service Pack 2 2016 (V 2102)

Removed column in hicad_stahlbau_01.rms
In the Report Manager configuration file HICAD_STAHLBAU_01.RMS the column DSTV Part type has been
removed.

Drawing attributes in BOM for active assembly
When creating a BOM with the Bill of Materials, for active assembly function, you have now the option to transfer
attributes of the model drawing as head data.

Axonometric representations of assemblies in Excel shipping lists
You have now the option to display assembly images in axonometric representation in shipping lists.

For this purpose three new parameters have been added to the he options on the "Settings" table sheet:
Assembly image height, Assembly image width and Assembly image representation. The Steel Engineering tem-
plates that are supplied with HiCAD are set to the default values for these parameters.

Example of a shipping list with AXO representations
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Transfer drawing attributes to BOMs for active assembly
When you call the BOM, for active assembly function, you have now the option to transfer attributes of the drawing
as head data.

Service Pack 1 2016 (V 2101)

Revised dialogue windows
The dialogue windows for BOM creation and for the settings for BOM creation have been revised. Their design has
been adjusted to the other dialogue windows in HiCAD and have a clearer structure.

Major Release 2016 (V 2100)

Excel BOMs for Plant Engineering and P+ID
With the release of Version 2016, new, conveniently adjustable BOM templates have been introduced to the Excel-
based system. These templates are:

n ENG_LD1_COMPONENTS1 and ENG_LD1_SYMBOLS) for P+ID, and

n anlagenbau_ohne_db_szn.rms, anlagenbau_ohne_db_rl.rms and anlagenbau_mit_db_geslen.rms for
Plant Engineering.

A detailed description of these BOM templates and notes on their adjustment can be found in the topic Adjust Tem-
plates - Plant Engineering and P+ID.

Bar lists - Residual lengths
The possibilities for the creation of bar lists in Excel BOMs have been enhanced. For instance, it is now possible to
specify residual lengths for semi-finished products. As a result, the corresponding semi-finished products will only
be used in the bar lists in a limited way.

Furthermore a new setting option is now available, which causes a preferred use of residual lengths, even if there
will be a larger amount of waste.
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Variant Editor

Service Pack 2 2016 (V. 2102)

Auxiliary functions for data transfer
The command line call of the Variant Editor VariantenEditor.exe supports two calling parameters, thus offering two
auxiliary functions for data transfer.

n Calling parameter autovaa

A variant is described by various attributes, some of which are identical or almost identical for all subtypes.
Examples of this are the file name or the order note. In practice, customers oftenmanage a list of parts that are
used in their company. If these customers now wish to use HiCAD variants, the question arises as to which of
the many variants actually match the corresponding entries of the customer list. Here, the calling parameter
autovaa can help you find the best matching variant for each entry. For this purpose the attributes of the variant
will be used.

n Calling parameter autoderive

This calling parameter provides the Variant Editor with an automatism that allows an automatic derivation of
existing variant files.
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Sheet Metal

Service Pack 2 2016 (V 2102)

Sheet along sketch
The revised sheet creation function New sheet along sketch allows a processing of sketches while the dialogue
window is open.

As soon as you have identified the sketch a preview of the new sheet will be displayed. To change the sketch, click

on the Process sketch icon. The Sketch tab and the Process sketch dialogue will then be displayed. Change
the sketch and confirm with Apply sketch. The Sheet along sketch dialogue will then be displayed again.

You can expand the Bend zones area by clicking the icon, and enter an individual radius and allowance for
each band zone.

The Offset direction and the Fitting direction each offer 3 options than can be selected (complete with visu-
alization) from a pull-downmenu.

(1) Sketch

(2) Bend radius changed

(3) Sheet thickness

(4) Fitting direction

Sheet Metal
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Sheet Metal cassettes
HiCAD now offers the new Sheet Metal cassette Design Variant for the construction of high-level functionality
facades with a striking appearance. This Design Variant allows you to create rectangular or polygonal cassettes
using Sketch technology.

The dialogue window consists of two tabs:

On the Base sheet tab you determine the corner points of the contour. You can either enter the coordinates,or
identify the points in the drawing, or select a sketch. Use the options beneath Close corner to to mitre attached
flanges (or sheets and bend zones, respectively) in one step. In the process, the bend zone will either be trimmed,
adjusted or, if you choose Mitre (indiv.) with lengthening ignored.

On the Attach flange you can then define the attached flanges. You can assign a different flange to each edge of
the base sheet. You can use most parameters of the Sheet Metal function Attach flanges here.

Click Preview to check and, if required, modify the result. Later changes can be applied via the feature log.
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Bore patterns, Moulding tools, Punching tools
Libraries for Bore patterns and Punching tools can be found in the Factory standards catalogue, and a library for
Moulding tools can be found in the Sheet tools catalogue of the Catalogue Editor. An expanding of these libraries
was previously only possible with 2-D parts that could be parameterized with the 2-D HCM (file format: .DCF). Now,
it is also possible to store planar sketches that can be parameterized with the Sketch HCM (file format: .KRA).

Agrafes
The Bore patterns library now also contains Agrafes. These can be used, e.g., for the anchoring of plates in facade
constructions; they are not visible from the outside.

Parameters in the catalogue:

l1 = 20

l2 = 20

d = 10,2

r = 5

t = 15

Insertion point: Centre of right semi-circle

The image below shows an agrafe for the left side. The right side can be selected via the Orientation.

Export section contours as DXF file
Three new functions for the export of section contours are available. These functions export the contours of the
blanks of Sheet Metal parts and Steel Engineering plates as DXF files. A prerequisite for this is that they are:

n BOM-relevant and

n have an Item number.

Blanks in the drawing will be ignored. HiCAD will always output a blank that is created temporarily for the export.
The current pre-settings in the drawing will be used for blank generation. The alignment is only unambiguous when
it has been specified with the Processing direction function.
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The 3 available functions support you with the selection of the sheets or plates:

All sheets: The developments of all sheet main parts in the drawing will be exported.

Sheets from list: All marked sheets and plates (part selection list) will be exported as a DXF file. The "quantity" of
the parts per item number will be taken from the drawing - irrespective of the selected and displayed parts.

Active sheet: Only the active sheet main part will be exported.

Proceed as follows:

1. After calling the function, select a directory for the DXF files.

A dialogue window with a list of the DXF files to be exported will be displayed

2. Select Close to end the export.

The files will then be located in the previously selected directory.

Export blank as DXF file
The behaviour during DXF export of Sheet Metal part and Steel Engineering plate blanks has changed.

This affects the following functions:

n Sheet Metal > Sheet development > Extras > DXF: Complete - All sheets

n Sheet Metal > Sheet development > Extras > DXF: Complete - Sheets from list

n Sheet Metal > Sheet development > Extras > DXF: Complete - Active sheet

Use these functions to export the blanks of Sheet Metal parts and Steel Engineering plates as DXF files. A pre-
requisite for this is that they are:

n BOM-relevant and

n have an Item number.

As of SP2, blanks in the drawing will be ignored. HiCAD will always output a blank that is created temporarily for the
export. The current pre-settings in the drawing will be used for blank generation. The alignment is only unam-
biguous when it has been specified with the Processing direction function.

Output of CSV files for DXF export
When outputting a temporarily created blank for the export, a list of DXF files is shown. This list can now be saved
as a CSV file.
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Click the icon to save the list as NAME.TXT or NAME.CSV to the selected directory.

In the file ABWPAR.DAT you can specify the output mode (Standard or Extended) (Default or Expanded) and the out-
put format (TXT file or CSV file). The settings will only take effect after a restart of HiCAD.

Increased performance for cleaning up of intersections
The calculation time required for the cleaning up of intersections could be reduced significantly. In test examples,
time savings from 30% to 50% could be observed.

Bend angle-dependent parameters in blanks
You have now the option to individually specify bend lined in blanks with the settings of the file ABWCOL_BEND_
ANGLE.DAT. Whether this file will be evaluated depends on the corresponding setting in the file ABWCOL.DAT.

Set the following parameter in the file ABWCOL.DAT to 1 and restart HiCAD:

B iegel in i en f a r be sol l in Abhäng igkei t vom B iegewinkel geset zt wer den ; Da t ei "sys/ abwcol_bend_ang le.da t "
( 1 : E igenschaf t en aus Dat ei l esen ; 0 : n i ch t aus Dat ei )
1

Then, change the settings in the file ABWCOL_BEND_ANGLE.DAT. Simply save the file to apply the changes after
updating of the blank.

Positive and negative bend angles are distinguished the file ABWCOL_BEND_ANGLE.DAT. Only the data within the
BEGIN-END block may be changed.
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(1) Bend angle 0°- 95°, Line code (Layer, Colour, Weight, Type) 2411

(2) Bend angle 95°- 360°, Line code (Layer, Colour, Weight, Type) 2311

(3) Bend angle -360°- -95°, Line code (Layer, Colour, Weight, Type) 2013

(4) Bend angle -95°- 0°, Line code (Layer, Colour, Weight, Type) 2117

Sheet developments for Lantek Flex3d as Favourites
Lantek Flex3d is a software solution for the automation of sheet metal cutting machine programming.

The interface between HiCAD and Lantek Flex3d is created via the export of the blank as DXF file.

To ensure a smooth data exchange, the blank needs to be composed according to Lantek-specific requirements.

1. Call the Parameters, Default setting to view the blank parameters.
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2. Click the icon to open the Favourites. Load the parameters for Lantek Flex3d.

3. Create the blank.

4. Now you can export the blank with the Export complete blank as DXF file function.

The format of the abwpar.dat and the abwcol.dat files has changed due to changes of the files in connection with
Bend angle-dependent bend line parameters.
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Service Pack 1 2016 (V 2101)

Coating
Use the Coating function to define the coating description, the coating colour (RAL colour, system colour) and the
coating type (outer side, inner side, edge) of a Sheet Metal main part.

The coating description and the coating type are taken over into the part attributes mask and are then also avail-
able in BOMs.

After selecting the outer sheet side you will be shown a preview of the coating, provided that you have not activated
any options requiring further value inputs. If you have activated the Apply immediately checkbox, the coating para-
meters will be applied immediately if the value inputs were correct, enabling you to select the outer sheet side of a
new Sheet Metal main part. Changes can then be made via the feature log.

If you want to change a surface after its identification, click the icon and identify the new surface.

If you are working in the shaded mode, the coating will be shown in the selected colour. You can select a RAL col-

our from the catalogue or a system colour as the coating colour. Activate and click the icon to display a selec-
tion list with the RAL colours. Otherwise, you can pick a system colour from the Colour selection box.

If you have selected a RAL colour, you can also take the description from the catalogue .

Use the icons to copy, for instance, the parameters of the outer side to the inner side and vice versa.

You can display the front surfaces in the colour of the outer side or inner side, respectively. This setting will be taken
over into the part attributes mask.

(1) Surface on the outer side

(2) Outer side
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(3) Inner side

(4) Front surface like outer side

Change semi-finished product subsequently
The functions

n New sheet from sketch

n New sheet along sketch

now offer the option to activate, deactivate of change the semi-finished product by double-clicking the feature.

Example

Double-clicking the feature Sheet from sketch opens the same-named dialogue window. You can then activate or

deactivate the Use-semi-finished product checkbox, or click to and a different semi-finished product. Con-
firm with OK.

Taking over of semi-finished product attributes to manually created article master
In the Configuration Editor you can specify the semi-finished product attributes that you wish to take over into the a
manually created article master. It is important that you created the article master yourself (manually) using the
Create new article master + assign function instead of applying a semi-finished products article master through
selection of a semi-finished product during base sheet creation.

Also, each catalogue table column to be taken over needs to be linked to a HELiOS attribute. The table will then be
transferred to HELiOS.

Change article number during sheet creation
When creating sheets with the functions

n New sheet from solid

n New sheet from surface

n Connecting sheet
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you have now the option to change the article number, if no semi-finished product has been selected. If the Use-
semi- finished product checkbox has been activated, the article number of the sheet will be generated auto-
matically.

Double-clicking the feature opens the dialogue window for sheet creation. Here, too, the article number can only
be changed if the Use-semi-finished product checkbox has not been activated.

Sheet Metal parts in workshop drawings
You can now select the following sectional views for Sheet Metal parts in the Views for sheets dialogue window that
you open by clicking the Sheet Metal button in the Drawing derivation dialogue window (Drawing > Itemisa-
tion/Detailing > Derive):

n Cut perpendicular to longest edge
This cut will only be created if a bend zone exists.

n Cut parallel to longest edge
This cut will only be created if a bend zone running perpendicular to the section path exists.

Fold flange
The user guidance texts of the Fold flange function have been revised:

n When you select a fold line for the Select, without sketch the text Straight line will appear in the input field.

n While the Select, without sketch function is active, the following user guidance texts will be shown in the info
bar at the bottom left of the HiCAD screen:

l Select 1st point, straight edge/line or surface for fold line (RMB = Further options)

l Select end point of line (RMB = Further options)
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Major Release 2016 (V 2100)

Discontinuation of HiCAD Unfold
HiCAD 2016 (Version 2100.0) will be the first version that does not contain HiCAD Unfold.

Attach flanges to surface
For the attaching of a flange to a surface, the following 4 options are available:

n Flange to surface, with free bend zone

n Flanges to surface, bend zone closed

n Flanges to surface, with drainage area

n Flanges to surface, with circular cut-out

Lengths and parameters are specified in the same way for all 4 variants.

You can enter a value for the desired length. If you right-click the Length input field, a context menu with further
options opens. You can then, for example, choose Pick distance to take the length directly from the drawing.

There are several options to define the reference of the length with the help of a graphic.

Likewise, the bend angle can either be entered in the Angle input field or taken from the drawing by right-clicking
the Angle input field and selecting Pick angle.

The Bend radius is located at the inner side of the bend zone. If you right-click the Bend radius input field you can
directly pick the radius from the drawing. For semi-finished products, the bend radius will always be taken from the
Catalogue Editor.
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The Fitting mode refers to the processing of the connecting sheet. Here, too, the selection is facilitated by a graph-
ical representation:

To obtain the blank (development) of the modelled Sheet Metal part, HiCAD offers you developments according to
different calculation methods (allowance methods) that take the material-dependent length change of the work-
piece during bending processes into account. For this, HiCAD also offers the common empirical, practice-oriented
allowance methods.

The calculation methods are represented by prepared, exemplary system files. In practice, however, each user will
store his ownmethod(s) in this way. Before attaching the flange you can select the required system file.

Attach flanges to surface, bend zone free

Use the Bend zone free function to attach flanges around a surface (base sheet). The selection of the top
surface determines the direction of the new flanges.

(1) Top surface

(2) Flange with free bend zone
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Attach flanges to surface, bend zone closed

Use the Bend zone closed function to attach flanges with closed bend zones around a surface (base sheet).
Sheets and bend zones will be lengthened up to the common intersection point of the inner edge. The selection of
the top surface determines the direction of the new flanges. 

Attach flanges to surface, with drainage area

Use the Drainage area function to attach flanges with drainage area around a surface (base sheet). The
selection of the top surface determines the direction of the new flanges. 

(1) Top surface

(2) Flanges with drainage area

Attach flanges to surface, with circular cut-out

Use the Circular function to attach flanges with a circular cut-out around a surface (base sheet). The selec-
tion of the top surface determines the direction of the new flanges.
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Several blanks for one sheet
Thanks to the enhanced blank functionality you can now derive several blanks with different parameter settings
from a Sheet Metal part. The parameter settings are saved in the blank. The structure of the corresponding function
has changed as follows: 

Functions Description

Adjust, Act-
ive sheet

Use this function to update all blanks of the active Sheet Metal part. If the blanks
have different blank parameters, these will be retained, as the blank parameters are
saved in the blank.

Pull-downmenu Update

Adjust, All
sheets

Use this function to update all blanks in the drawing, e.g. after changes to the Sheet
Metal part or the parameters. If the blanks have different blank parameters, these
will be retained, as the blank parameters are saved in the blank.

Parameters,
Individual

Use this function to change the blank parameters of a selected blank.

Parameters,
Default set-
ting

Use this function to change the blank parameters of new developments or blanks
that were created with the Develop sheet function. In the dialogue window, activate
the checkboxes and options for the parameters that are to be shown in the blank.

Parameters,
All

Use this function to change the blank parameters of all developments or blanks in
the drawing. In the dialogue window, activate the checkboxes and options for the
parameters that are to be shown in the blank.

Attach flange, with sketch
The operation of the With sketch option in the Attach flange dialogue window has been simplified: After selecting
the outer connecting edge you can only activate sketch edges, even if they are covered by a flange edge.

(1) Flange

(2) Sketch

LVDxml to ABW converter
The options of the Split LVD data tab have been expanded:
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Activate the Interpolate additional lines with increment: checkbox to calculate additional intermediate values for
the data in the ABW file.

Example:

The values for bend angles in the LVD data are 10°, 20°, etc.

If the increment is 2, the values for 12°,14°,16°,…will be entered into the ABW file.

BOM-relevance for new sheets
The part attribute BOM-relevant can be set for all new sheets in the SYS/ABWPAR.DAT file.

# Sheet s BOM-r el evan t ( yes=1 , no=0)

1

This setting will now also be evaluated by the functions Sheet from solid and Connecting sheet functions.
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Steel Engineering

Service Pack 2 2016 (V 2102)

Important notes

Note on updates

When you run the tool Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) – either during the
installation/update (Extended Settings > User Configuration tab) or later – various system files in the HiCAD sys
directory will be replaced, without any further query, with the files supplied in the HiCAD templates directory
which have been designed especially for a working with the selected module and the activated checkboxes
(e.g. …DSTV or Management + BIM). These files include, for example

n HiCAD masks for the part attributes (*.HDX),

n HELiOSmasks for projects, documents and articles (*.MSK),

n Various configuration files (*.HDB) and

n Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the ParKon-
figComp.exe tool!

If you have any questions, please contact your nearest ISD branch office.

Changed attribute masks when using the default template for Steel/Metal Engineering

If you have selected the ISD default template for Steel/Metal Engineering for the parameter configuration (s.a.), the
Part attributes masks in the HiDAD sys directory will be replaced accordingly. These masks have been slightly mod-
ified in SP2. For example, these masks now contain the fields Article No.and Standard instead of the fields "Part
name" and "Article number". Also, the position of some fields has changed.
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Assembly
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Beam
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Steel Engineering plate
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Sheet Metal part
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General 3-D part

Options / Settings

STB_PARAMETER.DAT / Configuration Management

Previously, various Steel Engineering settings could be specified in the system file STB_PARAMETER.DAT which is
now no longer available. Its setting options have beenmoved to the Configuration Editor at Steel Engineering.

Templates, Attribute assignment

Use the new Templates, Attribute assignment function to adjust the templates for attribute assignment

n of the Document and Drawing Management in Civil Engineering (Management + BIM) and

n of the DSTV-NC export (see also "Interfaces - What's New?")
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Templates, Attribute assignment dialogue window
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Standard templates for BIM Settings for

BIM_PDM_Draw-
ingnumberGeneration.ftd

Generation of individual drawing numbers

The number will be assigned to the HELiOS attribute
DRAWINGNUMBER_TEXT.

BIM_PDM_ItemnumberGeneration.ftd Generation of individual item numbers

The number will be assigned to the HELiOS attribute
COMPONENT_ITEMNR_TEXT.

BIM_PDM_Mount-
ingDrawingnumberGeneration.ftd

Generation of individual drawing numbers for mounting drawings

The number will be assigned to the HELiOS attribute
DRAWINGNUMBER_TEXT.

BIM_PDM_WSD_Assembly_
ArticleNumber.ftd

Configuration of the HELiOS document attribute SACHNUMMER
for detail drawings of assemblies(assemblies with a main part)

BIM_PDM_WSD_Assembly_Desig-
nation.ftd

Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of assemblies(assemblies with a main part)

BIM_PDM_WSD_Beam_ArticleNum-
ber.ftd

Configuration of the HELiOS document attribute SACHNUMMER
for detail drawings of beams

BIM_PDM_WSD_Beam_Desig-
nation.ftd

Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of beams

BIM_PDM_WSD_Multi_Designation.ftd Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of multi-part beams

BIM_PDM_WSD_Part_ArticleNum-
ber.ftd

Configuration of the HELiOS document attribute SACHNUMMER
for detail drawings of general parts

BIM_PDM_WSD_Part_Designation.ftd Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of general parts

BIM_PDM_WSD_SheetMetal_
ArticleNumber.ftd

Configuration of the HELiOS document attribute SACHNUMMER
for detail drawings of Sheet Metal parts

BIM_PDM_WSD_SheetMetal_Desig-
nation.ftd

Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of Sheet Metal parts

BIM_PDM_WSD_SteelPlate_
ArticleNumber.ftd

Configuration of the HELiOS document attribute SACHNUMMER
for detail drawings of Steel Engineering plates

BIM_PDM_WSD_SteelPlate_Desig-
nation.ftd

Configuration of the HELiOS document attribute BENENNUNG for
detail drawings of Steel Engineering plates

Standard templates for DSTV-NC Settings for the composition of

DSTV_NC_ORDERNUMBERTEXT .FTD Order number

DSTV_NC_DRAWINGNUMBERTEXT
.FTD

Drawing number

DSTV_NC_H_ITEMNUMBERTEXT .FTD Item number: Main part

DSTV_NC_H_PARTNUMBERTEXT
.FTD

Part number: Main part

DSTV_NC_ITEMNUMBERTEXT .FTD Item number: Loose parts

DSTV_NC_PARTNUMBERTEXT .FTD Part number: Loose parts

DSTV_NC_W_ITEMNUMBERTEXT .FTD Item number: Attached part

DSTV_NC_W_PARTNUMBERTEXT
.FTD

Part number: Attached part
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DSTV_NC_SIGNATURETEXT .FTD Lettering

DSTV_NC_FILENAME .FTD File name - NC

Please note:

n The BIM templates are used when the parameter PDM > Management + BIM > Production drawings > Create
HELiOS atributes from FTD file in the Configuration Editor has been set to Yes (Default). For the generation of
the drawing number and the item number, specify the number of digits for the parameter Generate n-digit draw-
ing number in the Configuration Editor at PDM > Management + BIM > Production drawings (or PDM > Man-
agement + BIM, respectively).

n The DSTV templates will be considered if the corresponding parameters in the Configuration Editor at Steel
Engineering > DSTV-NC have been set to Configuration, and in the DSTV-NC interface the option From tem-
plates file has been selected for letterings and the drawing number, part number, item number and order num-
ber.

Railing Configurator

Railings on beams in succession aligned in the same direction

If there are several beams in succession that are aligned in the same direction, the railing elements of these beams
will be combined into one segment assembly. As a result, continuous hand rails and knee rails will be formed on
these beams.

Left: Before HiCAD 2016 SP2; HiCAD 2016 SP2 or higher

Rectangular plates and Stiffeners

Automatic calculation of stiffener widths
If you selected the automatic calculation, the calculated width will be displayed in the (then greyed out) input field.
Previously the value of the last manual width adjustment was shown here.
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Forming of assemblies when inserting rectangular plates and stiffeners
When you insert rectangular plates or stiffeners, HiCAD will now proceed as follows for the creation of welded
assemblies:

If the reference beam is a main part that does not belong to an assembly, an assembly will be formed, with the
beam as assembly main part and the plate as sub-part.

If the reference beam belongs to an assembly, the plate will also be assigned to this assembly as a sub-part.

Connections

Front plate connection to flange (2330)

If you use the All equal button on the Stiffeners tab to apply the settings to all stiffeners in the Front plate con-
nection (2330), please note that the placing of the stiffeners will be automatically mirrored in the process. For
instance, if you have placed the 1st stiffener on the Front side, the 2nd stiffener will be placed on the Back side
when you call theAll equal function.

Filler plates with Usage

For the

n Front plate connection to web/flange (2320),

n Front plate connection (double-sided) to web (2322),

n Front plate connection to web (2330),

n Purlin joint, 2 plates with mitre cut acc. to DAST IH (2201) and

n End plate (2102)

the Usage Filler plate is now automatically assigned to filler plates. In this way you can, e.g. also create usage-
dependent configurations for filler plates, which will then be considered for drawing derivations.

Mounting drawings

Enhanced dialogue and output to external drawings

The dialogue window for the creation or modification of mounting drawings has been revised and enhanced. For
example, the bounding boxes for view groups can now be changed subsequently, and mounting drawings can now
also be output to external drawings.
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n Output to external drawings

As of SP2, mounting drawings can also be output to external drawings. Please note that mounting drawings in
external drawing files can only be updated after modifications in the original model drawing if you use document
and drawing management in civil engineering (Management + BIM). In this case you will use the corresponding
function in the Management+BIMmodule for the creation of the mounting drawings. In this way, the mounting
drawing will be linked to the original model drawing.

n Mounting drawing: Processing of bounding box

The dimensions of the transparent bounding box for the active view group can be changed via the functions of
the

menu. The following functions are available:

Change box dimensions, via facet + point
Here you select a surface of the box andmove it to the desired target point. The moving can also be performed
dynamically with the cursor.
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Change box dimensions, via facet + value
Here you select a surface of a box and determine the value by which the box is to be moved. The surface will be
moved by the value that you enter in the input field.

Also new is the option to re-determine the box, namely, via the following functions:

Re-determine box via 2 beams

Re-determine box, via plane

Re-determine box, via grid edge

The deleting of the box is now also possible - use the

Delete box
function for this.

n Extended settings

Clicking the button opens the dialogue window shown below. Here you can determine the size of the boxes
by specifying an excess length for different direction, i.e. enlarge the box in this way. Also, you can determine
here how external drawings should be handled.
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Retain visibility

Via the parameter Include new parts in list views of mounting drawings you can specify whether created new
parts are to be shown or hidden in the views of the mounting drawing upon its updating.

No
If a view of the mounting drawing contains hidden parts, the created new parts will also be hidden in these views.

Yes
Created new parts will always be shown in the views of the mounting drawing. This is the default setting. .

Management of mounting drawings via Document and Drawing Management in Civil Engineering (Management
+ BIM)

Like production drawings, mounting drawings can now be centrally managed with the functions of the Man-
agement + BIMmodule.

Production drawings

Alignment of beams and profiles

The Alignment of derived view functions in the context menu for parts (right-click)

n Active view as front view and

n Active view as top view

can now also be applied to beams and profiles. In this way you can specify the alignment of views in workshop draw-
ings.

When you specify the alignment, HiCAD will check whether the new alignment of the beam/profile is actually
allowed. Please note the following:

l Front views of beams show either the front side or the rear side of the web.

l Front views of round profiles must run horizontally, while allowing a free rotation about their axes. This
enables a rotation of the view-defining coordinate system for trimmed round beams in such a way that the
cutting angle can be dimensioned in the workshop drawing.

The result of the check will then be shown in a dialogue window.Here it will be listed for which of the chosen
beams/profiles the new alignment was successful, and to which no new alignment could be applied.
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Hide boltings

For each usage you can specify whether the boltings in the production drawing are to be shown or hidden. You can
find the relevant settings in the Configuration Editor at

Automatic drawing derivation > Production drawing > Usage-dependent > name > Views

with name being the name of the respective usage.

The following options are possible:

Hide none No bolts are hidden. This is the default setting and corresponds to the behaviour before
HiCAD 2016 SP1.

Hide all All bolts are hidden.

Hide only "site
bolts"

Only bolts with the "Site assembly" or "On-site construction" property are hidden.
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Please note:

n These settings do not apply to bolts which are located in a structure assembly (e.g. boltings that have been inser-
ted as loose parts). These bolts will
not be shown in the workshop drawing.

n The settings specified in the Configuration Editor when generating the production drawing will not be saved with
the model drawing. If a production drawing is updated, the current settings in the Configuration Editor will be
used, and not the settings that were active when the drawing was generated.

Sectional views for plate-like attached parts

When generating the production drawing, a sectional view will now not only be created and dimensioned for
attached parts of the type "Plate", but also for other, plate-like attached parts, such as flat steels.

Main parts without assembly

Main parts that do not belong to an assembly, e.g. parts on the highest level of a part structure, were previously
treated as main part of an assembly when a production drawing was created. This means: If the Main parts as
assembly checkbox beneath View groups to be created for: in the Drawing derivation dialogue window was activ-
ated, the settings for assemblies were used for these parts. If the Main parts, individually checkbox was activated,
the settings for the corresponding part type were used for these parts. If both checkboxes were activated, two draw-
ings (view groups) were created - one for the assembly and one for the individual part.

As of SP2 these parts will only be considered for the production drawing if theMain parts, individually
checkbox beneath View groups to be created for: in the Drawing derivation dialogue window was
activated. In this way it is assured that only one view group will be created for such a part.

New / expanded dimensioning rules

Parametric dimensions for Sheet Metal parts

You can now also use parametric Sheet Metal dimensions for the automatic dimensioning of Sheet Metal parts in
workshop drawings. The following rule are available for this purpose:

Rule Internal designation

132 Sheet length SHEETMETAL_LENGTH

133 Sheet width SHEETMETAL_WIDTH

134 Sheet height SHEETMETAL_HEIGHT

135 Parametric linear dimensions of Sheet Metal parts SHEETMETAL_PARA_DISTANCE

136 Parametric angular dimensions of Sheet Metal parts SHEETMETAL_PARA_ANGLE

137 Parametric circlr dimensions of Sheet Metal parts SHEETMETAL_PARA_CIRCLEDIM

Please note that for Rule 136 angles with 90, 180, 270 and 360 degrees will
never be shown.
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Example- 3-D sheet and detail of production drawing (front view) with dimensioning according to Rules 135, 136
and 137

Expansion of rules for sub-systems

The following rules for sub-systems:

n 71: Sub-system in upper flange area,

n 72: Sub-system in lower flange area,

n 73: Sub-system in web area,

n 74: Sub-system in upper flange and lower flange area and

n 75: Sub-system in upper flange, lower flange and web area

offer further selection options for reference selection:

n System axes

n Beam with attached parts
Beam start or end without front-mounted attached parts

n Beam without attached parts
Beam start or end with front-mounted attached parts
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Attached plates/sheets on relevant beam sub-parts

Sheets and plates in welded assemblies (welded frameworks) do not always refer to the main part of the assembly,
but may also refer to the neighbouring beams (defined by contact surfaces). Such beams need not necessarily be
main parts.

Based on the Rules 57 - 61, similar rules are now available for attached plates and sheets on relevant beam sub-
parts.

105 Attached plates/sheets on relevant beam sub-parts; one
dimension chain for each plate/sheet

ATTACHING_SHEETS_
SEPERATELY_RELVPROFS

106 Attached plates/sheets on upper beam sides on relevant
beam sub-parts; via bores or outer contour

ATTACHING_SHEET_
UPPERSIDE_RELVPROFS

107 Attached plates/sheets on lower beam sides on relevant
beam sub-parts; via bores or outer contour

ATTACHING_SHEET_
LOWERSIDE_RELVPROFS

108 Attached plates/sheets on web surface on relevant beam
sub-parts, before web, via bores or outer contour

ATTACHING_SHEET_
BEFORE_WEB_RELVPROFS

109 Attached plates/sheets on web surface on relevant beam
sub-parts, after web, via bores or outer contour

ATTACHING_SHEET_
BEHIND_WEB_RELVPROFS

Separate chain dimensions for different usages

You have the option to create separate chain dimensions per different usage for chain dimensions describing the fit-
ting situation of parts. To change this behaviour, open the STW_DimSettings.XML (conventional dimensioning set-
tings) file in the HiCAD sys directory and set the parameter SEPERATEDSUBPARTPOSITION to 1:

</PARAM><PARAM Name="SEPERATEDSUBPARTPOSITION" Typ="INT" Value="1">

The image below shows a beam with 4 plates for different usages (1=Front plate, 2=Reinforcement plate, (3)
Stiffener) and the front view of the production drawing.
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Attached parts - only dimension first contact point

When dimensioning attached sheet/plate parts or plates and beams that border on dimensionally relevant beams,
both contact points will always be dimensioned. If only the first contact point in the chain is to be dimensioned,
open the STW_DimSettings.XML (conventional dimensioning settings) file in the HiCAD sys directory and set the
parameter

</PARAM><PARAM Name="SUBPARTPOSITION" Typ="INT" Value="0">

to 1.

This setting affects the Dimensioning rules 8, 10, 66, 67, 68, 69, 70, 94,96, 110, 113, 114, 115, 116, 117.
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Example - (1) without changing STW_DimSettings.XML ; (2) with change of STW_DimSettings.XML
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Steel Engineering BOM in Excel

Shipping list with axonometric representation of assemblies

When generating BOMs using the HiCAD_Stahlbau.RMS template you can display an axonometric representation
of the assembly as an image in the Shipping list in Excel format.

Example of a shipping list with assembly images

More information can be found in the News for the Report Manager.

Service Pack 1 2016 (V 2101)

General Design Variants

Bar Configurator

Use the Bar Configurator dialogue window to fill the area between 4 boundary beams, or the area between 4 edges
of a sketch with bars. The placing of bars along composite edges is also possible.
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Example - (1) Bars between beams; (2) Bars along composite edge
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Mounting drawings

Redesigned dialogue window

The dialogue window for the creation and processing of mounting drawings has had a redesign:

New dialogue window
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New options

The following new option for the specification of bounding boxes for detail views are available:
New view group by selection of 2 beams

Here the bounding box is determined by the selction of 2 beam ends. HiCAD automatically cal-
culates the smallest possible cuboid that completely covers the two beams, as visualized it as a trans-
parent box in the drawing.

View group 1: Beam (1) and (2); View group 2: Beam (3) and (4)

New view group by plane selection

The bounding box is determined by the selection or definition of a processing plane. For the selection
or definition of the processing plane you can use the same options as for the Processing plane func-
tion. The bounding box is created by extrusion of the processing surface to the front and to the back.

New view group by grid edge selection

The bounding box is created by the selection of a Steel Engineering grid edge. lThe bounding box is
created by extrusion of the edge running perpendicular to the grid edge to the front and to the back.

The transparent box that visualizes the bounding box can be changed via the functions beneath Tools, View
groups. The bounding box can also be rotated.

Also new is the option to auto-create grid annotation tags for multi-level grids and add chain dimensions.
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Staircase and Railing Configurator

Railing Configurator - Lateral post connections

The lateral post connection has been optimized. You can now also choose between 2 bores or 4 bores in fixing
plates.

Railing Configurator - Insertion of corner posts

When inserting corner posts, you can now specify on the Corner post - Substructure tab how the post is to be
mounted to the substructure.
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Railing Configurator - Corner rods

For vertical rods you have the additional options to place one rod in the corner. To do this, activate the Corner rod
checkbox on the Infill tab.

Input values for vertical rods with booms
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Railing with corner rod

Change/Update stairs and railings

The functions

n Update connection and

n Change connection

can also be applied to stairs and railings that were created with the Staircase/Railing Generator if you have sub-
sequently deleted parts that were created by the corresponding variant. However, these deleted parts will be re-cre-
ated upon updating if these are required due to the parameters and the geometrical situation.
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Boltings

New bolt types

Steel Engineering boltings now also include the new bolt types

n DIN EN 14399-7,

n DIN EN 14399-8 and

n DIN EN 14399-10.

Process beams

Selection of beams

Previously, assembly points could be snapped during selection of beams and profile, causing the confusing error
messagePart is no Steel Engineering part. From HiCAD 2016 SP1 onwards, only actual beam and profile-related
data will allow the selection of beams.

Handling of article masters during exchanging of semi-finished products

The handling of manually assigned article masters during exchanging of semi-finished products can be specified in
the Configuration Editor at System settings > HELiOS.

The following setting options for the parameter Handling of article master are available:

n Query
If the semi-finished product to be exchanged has a manually assigned article master, a query will be issued:
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If you choose Yes, the article master of the semi-finished product to be exchanged will be deleted and, if
required, replaced with the article master of the semi-finished product to be exchanged. If you choose No, the
article master of the semi-finished product to be exchanged will be retained unchanged. This is the default set-
ting.

n Delete
An article master that is manually assigned to the semi-finished product to be exchanged will be deleted without
any further query and, if required, replaced with the article master of the semi-finished product to be exchanged.

n Retain unchanged
An article master that is manually assigned to the semi-finished product to be exchanged will be retained
unchanged in the exchange process. No query will be issued.

At Taking over of semi-finished product attributes you can additionally specify which semi-finished attributes
will be assigned to the manually assigned article attributes. The assignment must be defined as follows:
Semi-finished product attribute;Article attribute
Each assignment must be specified in a separate row in the collection, e.g. as follows:

The String Collection Editor is initially empty by default.

Connections

Assigning of boltings

The assigning of bolting has been changed for the following connections:

n Beam to web with 2 Plates + Stiffener (1211),

n Front Plate Connection to Web/Flange (2320)

n Front Plate Connection to Flange (2330)

1211
The bolting is inserted as a Bolting group. Next to Assignment on the Boltings tab you can specify whether this Bolt-
ing is to be assigned to the assembly of the 1st beam or whether it is to be inserted as a "Loose part". If you choose
the "Loose part" option, the Bolting group will be inserted as a separate assembly on the same level as the
assembly of the 1st beam.

2320
The bolting is inserted as a Bolting group. Next to Assignment on the Boltings tab you can choose whether this
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Bolting group and the reinforcement plates are to be assigned to the assembly of the 1st beam or are to be inserted
as Loose parts. If you activate the Assembly (1st beam) option, the Bolting group and the reinforcement plates are
assigned to the assembly of the 1st beam. If you activate the Loose partoption, the Bolting group will be inserted
as a separate assembly on the same level as the assembly of the 1st beam. The reinforcement plates will be
assigned to a structure assembly called Loose parts that also contains filler plates. This structure assembly is also
located on the same level as the 1st beam.

2330
The bolting is inserted as a Bolting group. Next to Assignment on the Boltings tab you can specify to which
assembly the boltings and the reinforcement plates are to be assigned. If the Assembly 1st beam option is active,
the boltings and the reinforcement plates will be assigned to the assembly of the 1st beam. If you activate the
Loose partoption, the Bolting group will be inserted as a separate assembly on the same level as the assembly of
the 1st beam. The reinforcement plates will be assigned to a structure assembly called Loose parts. If you have
also inserted filler plates, reinforcement plates
and filler plates will be located in this assembly.

Purlin joint, 2 plates with mitre cut acc. to DAST-IH (2201)

Use this new function to connect two beams by means of two rigid front plates that are bolted together. These can
either be flush or with excess length to the top, the bottom or the sides. The bolting can be aligned symmetrical or
unsymmetrical. If required, the beams can be automatically shortened, lengthened or mitre cut. Furthermore, weld
seams or filler plates can be directly inserted.

The connection can be made either to the web or to the flange. Allowed beam types are I-beams, U-beams, L-
beams, T-beams, Z-profiles, pipes and hollow profiles.

The connection can either be user-defined or configured via predefined DAST tables integrated in HiCAD.

This connection replaces the previous Purlin joint 1201.

Example 1 - FRont plate connection (1) with non-pre-planned filler plate (2)

End plate (2102)

Use this function to connect an end plate to a beam. The plate can be inserted with a bolting, pre-drilled, with or
without filler plates, and with or without base. If desired, weld seams can be directly inserted.
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Possible beam types are I-beams, U-beams, L-beams, T-beams, Z-profiles, pipes and hollow profiles.

Allowed semi-finished products for the plate are simple Plates, Flat steels, FLUTZ profiles, A3 Steel bars by Frank-
stahl or C3 Stainless steel bars.

The Design Variant 2102 replaces the previous Design Variant End plate 1102.

Example - End plate

Front plate connection (double-sided) to web (2322)

Use this function to connect two beams via front plate connections to a third beam. The connection can be made
to the web or to the flange - with or without filler plates.

Depending on the fitting situation, the connected beam will be automatically notched appropriately. Furthermore,
weld seams can also be directly inserted and annotated.

The connection can be a user-defined connection or configured via predefined DAST tables supplied with HiCAD.

Supported beam and profile types are I-beams, U-beams, T-beams, Z-profiles, pipes and hollow profiles.

(1) 1st beam tobe connected, (2) 2nd beam tobe connected, (3) Target beam towhich the connection is to bemade
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Workshop drawing

Sheet Metal

The following sectional views can now be selected for Sheet Metal parts in the Views for sheets dialogue window:

n Cut perpendicular to longest edge

This sectional view is only created id a bend zone exists.

n Cut parallel to longest edge

This sectional view is only created if a bend zone running perpendicular to the section path exists.

Hide boltings

Bolts in workshop drawings can be hidden if desired. This is currently only possible via the Windows_Registry. To do
this, select

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD 2016

and create a new key:
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Key Name WorkshopDrawing

DWORD
value

Name ModeScrewInvisibility

Type DWORD

Value 0 No bolts are hidden. This is the default setting and corresponds to the
behaviour of HiCAD before Version 2016 SP1.

1 All bolt are hidden.

2 Only bolts with the property "Site assembly" or "Site production" are hid-
dden.

<0 or >2 The default value 0 is used.

These settings do not apply to bolts and screws that are located in a structure assembly (e.g. to Boltings
inserted as "Loose parts"). These bolts and screws are
not shown in the workshop drawing.

Aligning of Steel Engineering plates

The functions beneath Alignment of derived drawings in the context menu for parts:

n Active view as front view and

n Active view as top view

can now also be applied to Steel Engineering plates. This allows you to specify the alignment of plates in Workshop
drawings. HiCAD will check whether the new alignment of the plate is actually allowed. The top view
must be perpendicular to the upper or lower plate side!

The result of the check will then be shown in a dialogue window. Here it will be listed for which of the chosen plates
the new alignment was successful, and to which no new alignment could be applied.
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New/changed dimensioning rules

Separate dimensioning of beam sub-parts which are not vertical to main part axis

The following new rule allow a dimensioning of beam sub-parts that are not vertical to the main part axis.

Rule Internal designation

113 Beam sub-parts, not vertical to main part axis ATTACHING_ PROFILES_
INUPPERFLANGE

114 Beam sub-parts on lower flange, not vertical to main part
axis

ATTACHING_PROFILES_
INLOWERFLANGE

115 Beam sub-parts in front of web, not vertical to main part
axis

ATTACHING_PROFILES_BEFORE_WEB

116 Beam sub-parts behind web, not vertical to main part axis ATTACHING_PROFILES_BEHIND_WEB

117 Beam sub-parts, not vertical to main part axis ATTACHING_PROFILES

If you select the direction Parallel to beam axis you can, depending on the respective position, create a chain of
dimensions for the beam sub-parts.

If you select the direction Vertical to beam axis, a separate chain of dimensions will be created - vertical to the
main part axis - for each beam sub-part.

Example 1 - 113 -116 parallel to beam axis
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Dimensioning of bores with intersecting axes

Use the new dimensioning rule

123: Angle between bore axes (BORE_ANGLES)

to dimension bores with intersecting axes - this rule is of particular importance for machine-controlled drilling. This
rule dimensions bores in beams and profiles with circular cross-sections (round steels, steel pipes), but only if the
bore axes are running in the direction of the beam/profile axis.

Example - Side view, from left
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Dimensioning rules for various bore types

When creating production drawings, different dimensioning rules are now available for different bore types:

Rule Internal designation

124 Beam processings of the type Slot PROF_LONGHOLES_ONLY

125 Beam processings of the type Slot in upper
flange

PROF_LONGHOLES_ONLY_
INUPPERFLANGE

126 Beam processings of the type Slot in lower flange PROF_LONGHOLES_ONLY_
INLOWERFLANGE

127 Beam processings of the type Slot in web PROF_LONGHOLES_ONLY_INWEB

128 Beam processings of the type Circular bore PROF_CIRCLEBORES_ONLY

129 Beam processings of the type Circular bore in
upper flange

PROF_CIRCLEBORES_ONLY_
INUPPERFLANGE

130 Beam processings of the type Circular bore in
lower flange

PROF_CIRCLEBORES_ONLY_
INLOWERFLANGE

131 Beam processings of the type Circular bore in
web

PROF_CIRCLEBORES_ONLY_INWEB

Only bores with bore axis in viewing direction will be considered. For circular bores, a separate chain of dimensions
will be created for each bore diameter;

Example
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Dimensioning rules for stairs

For staircases you can now use the following dimensioning rules:

 Regel Interne Bezeichnung

Total dimensions,
axially parallel

2 Assembly length ASSEMBLYLENGTH

19 Assembly height ASSEMBLY_HEIGHT

20 Assembly width ASSEMBLY_WIDTH

Transport dimen-
sions

90 Diagonal total dimensions of an
assembly

TOTAL_SIZE_ASSEMBLY

Angles between
stringers

111 Angle between beammain part and
connected sub-part beams

ANGLE_CONNECTED_PROFILES(for
the main part)

112 Angle between relevant beams and
connected sub-part beams

ANGLE_CONNECTED_PROFILES_
RELPROFS (for the relevant sub-parts)

Sub-parts 94 All attached parts of relevant beam
sub-parts, via outer contour

ATTACHING_PARTS_RELVPROFS

96 Attached Sheet Metal parts with
bores on relevant beam sub-parts

ATTACHING_SHEETS_RELPROFS

110 Beam sub-parts on relevant beam
sub-parts

ATTACHING_PROFILES_VERT_
RELVPROFS (for the relevant sub-parts)

Bores 98 Bores in web of relevant beam sub-
parts

PROFBORES_INWEB_RELVPROFS

99 Bores in upper flange of relevant
beam sub-parts

PROFBORES_INUPPERFLANGE_
RELVPROFS

100 Bores in lower flanges of relevant
beam sub-parts

PROFBORES_INLOWERFLANGE_
RELVPROFS

101 Bores in flanges of relevant beam
sub-parts

PROFBORES_INFLANGES_
RELVPROFS
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Other new features and enhancements

Adding of 3-D parts to Steel Engineering parts

The adding of 3-D parts to a Steel Engineering parts may cause problems with subsequently called functions, e.g.
mitre cuts, Steel Engineering connections, NC/NCX export, deriving of drawings, etc. Attributes (e.g. weight,
length, etc.) may also be calculated incorrectly.

In such cases, HiCAD will display the following warning message after selecting 3-D-Standard > Process > Add

function :

You can then decide whether you want to execute the function or not.

If you do no longer want this message to be displayed, activate the Suppress message checkbox. In this case, the
adding will either be accepted or refused, depending on your last choice in the message window.

Please remember that the checkbox status applies only to the current HiCAD session!
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Major Release 2016 (V 2100)

Please note:
When creating boltings via Design Variants as accessory parts (Staircase/Railing Configurator) or loose
parts (Connections 2320, 2322, 2330, 1305, 1306, 1211) in a non-BOM-relevant assembly, no DSTV
BOM can be written, because the superordinate part is missing. This can be avoided for thementioned
connections by activating the Assignment: Assembly option on the Boltings tab of the corresponding dia-
logue window. Bolting structures created by the Staircase and Railing Configurator must currently be
adjustedmanually.

Mounting planning - Basic functionality

Create mounting drawing

You can now create, modify and expand Steel Engineering Mounting drawings in only a few steps.

These mounting drawings have the following properties:

n The drawings show a section through the drawing. The drawing views are cuboid detail views, the size of these
cuboids can be individually adjusted in the dialogue.

n The essential parts can be automatically annotated.

n Grids can also be automatically annotated.

n The drawings contain one or several views which are arranged in view groups.

n The drawings are saved in the drawing, i.e. HiCAD will create corresponding Sheet areas

For the creation, changing and updating of mounting drawings the functions

n Mounting drawing and

n Update mounting drawing

are now available at Drawing > Itemisation/Detailing.
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Mounting drawing dialogue window

Please note that themounting planning functionality supplied with theMajor Release HiCAD 2016 (V.
2100.0) is only a basic functionality, which will be continually enhanced in future versions.
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Settings for mounting drawings in the Configuration Editor

As with production drawings, you can specify various settings for mounting drawings in the Configuration Editor. You
can find these settings at er Automatic drawing derivation > Mounting drawings:

Additional settings in the 'Part annotation templates'* function

The Part annotation templates function has been expanded for mounting drawings. There, you can now specify the
representation of annotations for main parts, sub-parts, standard parts and boltings:

Standard template files for
mounting drawings

Annotation settings for

POSNUMMER_MTZ_HAUPTTEIL Main parts in assembly drawings

POSNUMMER_MTZ_NEBENTEIL Sub-parts in mounting drawings

POSNUMMER_MTZ_NORMTEIL Standard parts in mounting drawings

POSNUMMER_MTZ_
VERSCHRAUBUNG

Boltings in mounting drawings
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Connections

Front plate connection - New functions

New front plate connections are available, replacing the previous connections 1320 and 1322 and providing sig-
nificantly more flexibility during insertion.

Front plate connection to web/flange (2320)

Use this function to connect 2 beams via a bolted front plate connection. The connection can be made to the web
or to the flange - with or without filler plates. Depending on the fitting situation, the connected beam will be auto-
matically notched appropriately. Furthermore, weld seams can also be directly inserted and annotated.

The connection can be a user-defined connection or configured via predefined DAST tables supplied with HiCAD.

Supported beam and profile types are I-beams, U-beams, T-beams, Z-profiles, pipes and hollow profiles.

(1) Beam tobe connected, (2) Target beam towhich the connection is to bemade, (3) Created connection, (4) With filler plates

Front plate connection to flange (2330)

Use this function to connect two beams via a bolted front plate connection. The connection can be made to the
web or to the flange - with or without filler plates. In contrast to the connection 2320 the connected beam will not be
automatically notched. Furthermore, you have the option to insert stiffeners between the flanges of the beam to
which the connection is to be made.

The connection can be a user-defined connection or configured via predefined DAST tables supplied with HiCAD.

Supported beam and profile types are I-beams, U-beams, T-beams, Z-profiles, pipes and hollow profiles.
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(1) (1) Beam to be connected, (2) Target beam to which the connection is to bemade, (3) Created connection with stiffeners

Front plate connection to web, double-sided (2322)

Use this function to connect two beams via front plate connections to a third beam. The connection can be made
to the web or to the flange - with or without filler plates.

Depending on the fitting situation, the connected beam will be automatically notched appropriately. Furthermore,
weld seams can also be directly inserted and annotated.

The connection can be a user-defined connection or configured via predefined DAST tables supplied with HiCAD.

Supported beam and profile types are I-beams, U-beams, T-beams, Z-profiles, pipes and hollow profiles.

(1) 1st beam tobe connected, (2) 2nd beam tobe connected, (3) Target beam towhich the connection is to bemade
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Beam to web, with 2 plates and stiffener (1211)

This function now offers the option to define whether the bolting is to be assigned to the assembly of the 1st beam
or if it is to be inserted as a "loose part". The Bolting tab has been expanded for this purpose.

Bolting assignment
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Angle connection, one sided (1305) and double-sided (1306)

The assigning of boltings has changed here. The Bolting tab has been expanded for this purpose.

n If you have selected the production type Workshop for one of the beams, you can specify beneath Assignment
by activating the corresponding radio button whether the boltings are to be assigned to the assembly of this
beam, or if they are to be inserted as a structure assembly called "Loose parts".

n If you have selected the production type Site, all parts of the connection will be combined into one structure
assembly called "Loose parts".

Example - Assignment of boltings
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Gratings

Calculation of net weight and net surface area

Previously, gratings were handled like plates with regard to the calculation of their weights and surface areas. It is
now possible to specify the surface area per square metres of installation area for Gratings according to
DIN 24537. For this purpose, the NETOBERFL column is available in the corresponding table of the Catalogue
Editor.

The default setting is the value 0. For the calculation of the net weight and the net surface area, enter the desired
value here and save the table.

When inserting gratings, the value specified in the table will be considered for the calculation of the net surface
area. In addition, subtractions and chamfers are also taken into account when weights and surface areas are cal-
culated.

(1) Grating insertion with value 0, (2) Grating insertion with value 5.5, (3) Grating with chamfer
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Cut beams

New part attribute: Trimmed length

When beams are trimmed, the value assigned to the part attribute Length will be the total length of the trimmed
beam. If two trimmings are applied to a beam, the calculated length will be the smaller of the two individual total
lengths after applying the trimming. The beam length and the trimmed length will then be identical.

Line for 1st trimming; (2) Line for 2nd trimming

Exceptions are cases where one of the trimmings is performed at a 90° angle. In such cases, the length resulting
from the 90° trimming will not be considered for the calculation of the minimum (the reason for this are processing
steps with a saw). Use the part attribute

Trimmed length (§24)

for a correct calculation of the trimmed length. This attribute can, for instance, be used for annotations, in part
attribute masks or in BOMs.
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BOMs in Excel

Use of residual lengths for bar optimisation

For bar optimisations ("bars"=bar-shaped symbolic representations of beams) you have now the option to shorten a
particular number of bars by specifying the number of residual lengths. This can be done with waste minimisation or
with a preference of residual pieces.

The specification of the bars and the number of residual pieces must be enteredmanually into the Excel tem-
plate before creating the BOM.

For this purpose, the Bar settings sheet has been added in the HiCAD_Stahlbau.xlsx template for the output of
BOMs to Excel.

n New is the Qty. column. Here you can enter the number of residual pieces. During the placement, a semi-fin-
ished products/lengths combination with quantity (=Residual pieces > 0) will be used, together with an unlimited
number of bars.

n At the bottom of the Bar settings sheet you will find the Prefer residual lengths switch. The default setting is
false. In this case the bars will be used in such a way that the amount of waste is as small as possible. If the
switch is set to true, the bars with a quantity of > o will be preferably used. The amount of waste, however, can
be greater here.

An example:

The drawing shown below consists of three beams of the type HEA 340 and a length of 5500 each.

Profiles with a length of 6000 and 6500 are to be used. When using the length of 6500, however, not more than one
residual piece is to be created. For this to happen, the default settings on the Bar settings sheet in the file HiCAD_
Stahlbau.xlsx must be changed as follows:
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The amount of waste is to be as small as possible; therefore, the Prefer residual lengths switch must remain on
false.

If you generate the Excel file with this setting, three bars with a length of 6000 mm will be used. The amount of
waste will be 1500mm here.

In contrast, if you set the Prefer residual lengths switch to true , two 6000 mm bars and one 6500 mm bar
(because of Qty. = 1). Here, the amount of waste will be 2 x 1000mm.

If the quantity of the 6500mm bars was 2, one 6000mm bar and two 6500mm bars would be used etc.

Further information on the output of BOMs can be found here.
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Staircase configurator

Stringers tab changed

The Stringers tab of the Staircase Configurator has been changed. Here, you now have different dialogues for
stringers made of Sheet Metal U and Sheet Metal C.
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Railing Configurator

Selectable bore grid in Post - Substructure tab

The Post - Substructure tab has been expanded.

If you select the Post connection, top variant, you can choose a bore grid. You have now the following options:

n No bores,

n 2 bores

n 4 bores
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Derived drawings

Usage-dependent settings

In the Configuration Editor, the assigning of usage-dependent settings has been simplified and enhanced.

n The selection of the usage row takes no longer place via a key name, but via plain text.

n The assigning can be limited to particular part types. For example, if you want to assign the usage-dependent
setting STRINGER only to handrails of the type "Flat steel", select the same-named entry beneath Part type.

n The usages can be neatly arranged in groups. Predefined are the groups Railing, Metal Engineering, Steel Engin-
eering and Others.

n The creation of new assignments, and also the definition of new usage settings can take place directly ion the
list of assignments.

Shortened view

Previously, only views of beams and profiles could be shortened. This is now also possible for other views, e.g.
views of Sheet Metal parts etc. For this purpose, the Settings for views dialogue window has been modified. There
you can specify beneath Shortened view which views are to be shortened.
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If you also want to shorten other views , e.g. views of the Sheet Metal parts, activate the Show other views as
shortened views checkbox, enter the minimum width of the area to be removed by the shortening, and the dis-
tance of th shortening to the relevant geometry.

(1) Distance of shortening to relevant geometry

If the settings for drawing derivation are loaded from a configuration, the settings specified in the Configuration
Editor at Automatic drawing derivation > Production drawing > Usage-dependent > name > Views > Shortened
view will be evaluated. name denotes the name of the corresponding usage.

Sectional views for flat steels

You can now also create sectional views for standard beams of the category Flat steel for derived drawings, if this
was correspondingly specified at View groups.
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Setting: Standard part annotation

In HiCAD 2015, standard parts were annotated if you explicitly activated the annotation of sub-parts or (as of SP1)
the annotation of boltings. As of HiCAD 2016 the annotation of standard parts can be switched on or off, inde-
pendent of other annotation types.

If the settings for drawing derivation are loaded from a configuration, the settings specified in the Configuration
Editor at Automatic drawing derivation > Production drawing > Usage-dependent > name > Views > Shortened
view will be evaluated. name denotes the name of the corresponding usage.
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New dimensioning rules for trussed rafters

The following new dimensioning rules are available for workshop drawings:

n 90: Diagonal total dimensions of an assembly
Use this rule to create diagonal individual dimensions (shipped dimensions) between the outer corners of an
assembly.

n 111: Angle between beammain part and connected sub-part beams /
112: Angles between relevant beams and connected sub-part beams
Here, angles between directly connected beams the angles to each other of which are not 90° or180° are dimen-
sioned. Angles which are not displayable in the corresponding view will not be created either. Important: The
dimensioned angle is not necessarily located in the screen plane, put can be located anywhere in space. Rule
111 dimensions only angles between the beammain part and the beam sub-parts connected to it. Rule 112
dimensions all relevant beams and the beam sub-parts connected to them.

n 80: Connected sub-part beams on relevant beams
Here, all beams which are directly connected to another beam are dimensioned in a chain. Clear distances
between the beams will also be considered. The already existing Rule 77: Connected beam sub-parts only con-
siders the beam sub-parts which are not connected to the beammain part. The new Rule 80, in contrast, also
considers all relevant beams and the beam sub-parts connected to them.
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Plate-like profiles in sectional views

Previously, sectional views were only created for Steel Engineering plates. This is now also possible for plate-like
profiles. Therefore, the dimensioning rules for plates now also apply to plate-like profiles in sectional views.

View groups - Frames, alignment, visualisation

A new listbox for frames and view groups offers the following selection options:

n Do not insert

n Always insert

n Insert, if there are multiple view groups

The default setting is Always insert. This presetting can be changed in the usage-dependent templates in the Con-
figuration Editor at: Automatisc drawing derivation > Production drawing > Usage- dependent > ... > View
groups > Frames around view groups.

If a drawing frame contains only one view group, it will be centred in the drawing frame. This behaviour, too, can be
changed in the Configuration Editor, at Automatic drawing derivation > Production drawing > Drawing > Centre
individual view group. If you deactivate the checkbox, individual view groups will be placed at the top left of the
drawing frame instead.
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Colour, layer and line type of the frames can be specified in the Configuration Editor at System settings > Visu-
alisation > View group.

If the centring leads to collisions with locked areas (e.g. the title block), the view group will be placed at the
top left.
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Steel Engineering - Management + BIM

Service Pack 2 2016 (V. 2102)

Important note on updates!
When you run the tool Computer Parameter Configurator (HiCAD exe\ParKonfigComp.exe) – either during
installation or later – and activate the Management + BIM checkbox there, various system files in the HiCAD
sys directory will be replaced (without any further query!) with the files supplied in the HiCAD templates dir-
ectory which have been designed especially for a working with the Management + BIM module. These files
include, for example

n HiCAD masks for the part attributes (*.HDX),

n HELiOSmasks for projects, documents and articles (*.MSK),

n Various configuration files (*.HDB) and

n Template files for annotations (*.FTD).

You should therefore always make backups of all files that you have customized before using the ParKon-
figComp.exe tool!

If you have any questions, please contact your nearest ISD branch office.

New dialogue masks
The dialogue masks for Document and Drawing Management in Civil Engineering have been redesigned. For
example, the new dialogue masks for documents and articles now contain the attribute CONSTRUCTION_
SECTION for the identification of construction units (documents and articles) and the attribute STAHLBAUAUTO for
a subsequent setting of the Steel Engineering Drawing Management identifier (article).
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The new HELiOS masks for project, article and document data input
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When specifying the parameter configuration accordingly, the HELiOS dialogue masks will be replaced with the
new masks.
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Modified Ribbon
The Workflow functions at Management + BIM > HELiOS PDM functions for... have been removed. The functions
are still available on the HELiOS PDM tab and in the context menu of the drawing beneath HELiOS.

Indication of Workflow status in ICN
Parts from Released drawings and parts from drawings in the Checkup status are now indicated as such in the
ICN.

Management of mounting drawings
Besides production drawings you can now also create, update and manage mounting drawings with the Man-
agement + BIM functions. For this purpose you use the Dazu steht Ihnen unterdie Funktion

Mounting drawing

function on the Management + BIM > Drawing. The function works in the same way as the same-named function
at Drawing > Itemisation/Detailing, but directly assigns the corresponding HELiOS links to the drawings.

In contrast to the function at Drawing > Itemisation/Detailing, no separate function for the updating of
themounting drawing is available here. As you would do for production drawings, use the Create / Update
drawing instead.

New arrangement of settings in Configuration Editor
The Management + BIM settings in the Configuration Editor have been rearranged. They can still be found at ...
PDM > Management + BIM.
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Furthermore, you can now find the switch for the activation of the document and drawing management in civil
engineering with BIM here. In older versions these settings could be found in the system file STB_
PARAMETER.DAT. This checkbox will be activated automatically when you perform the parameter configuration.

Transfer article attributes of semi-finished products to document attributes of detail drawings
When generating detail drawings with the Management + BIM functions you have the option to transfer article
attributes of the semi-finished products to the document attributes of the detail drawings. Such document attributes
can, for instance, be used in the HELiOS result lists as filters or search criteria.

The assigning takes place in the Configuration Editor at ...PDM > Management + BIM > Production drawings >
Transfer article attributes.

To transfer article attributes of the semi-finished product to the document attributes of the detail drawing, click on

the icon and define the desired assignments. Each assignment is defined in one row and is composed like this:

Article attribute;Document attribute

If, for instance, you want to assign the Article attribute BENENNUNG (Designation) to the Document attribute
BEMERKUNG (Comment), the assignment must look like this:
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Creation of CAM data
You have the option to create the CAM data for the parts in the production drawings of the current model drawing,
manage them in HELiOS and link them accordingly. This is possible for the formats DSTV-NC, NCW, DXF and STEP.

The creation of these CAM data can now take place manually or automatically. This can be specified in the Con-
figuration Editor at ...PDM > Management + BIM > External production drawings > Create CAM data.

The default setting is Manual, i.e. you need to execute the Production function for the creation of the CAM data.

Which CAM data will be created also depends on the settings at ...PDM > Management+BIM > External pro-
duction drawings. Only those CAM data will be created that you explicitly selected in the settings. For instance, if
all settings for the Create ... data parameters have been set to No, no CAM data will be created. This applies both
to the automatic and to the manual creation, i.e. even the Production function will then generate no CAM data.

Via the switch CAM data for unprocessed beams you can specify whether "unprocessed" beams are to be con-
sidered for the CAM data creation or not. In the drawing you distinguish between processed and unprocessed
beams, depending on the corresponding feature log entries of a beam. For instance, a lengthening, trimming or
moving of points in a rectangle will not make a beam a "processed" beam. All other processings, e.g. bores, sub-
tractions, notches etc. will make the beam a "processed" beam.

Also new is the possibility to select the part types to be considered for STEP export.

NCW format for part data
You can now automatically create NCW data for part, manage them in HELiOS and link them.
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To enable the creation of this file format, the settings in the Configuration Editor at ...PDM > Management + BIM >
External production drawings must have been specified accordingly. The ISD default setting is No, i.e. no NCW
data will be created.

Please note in this context that the Export... menu has been expanded.

Automatic creation of DWG files of production drawings during the Workflow
DWG files of production drawings can now be automatically created

n upon Checkup and Release or

n upon creation and updating

of drawings. For this purpose, the settings in the Configuration Editor at PDM > Management + BIM > External pro-
duction drawings have been expanded accordingly.

Please note in this context that the Export... menu has also been expanded.

Derive assembly

When you use the Derive, Active assembly(-ies) with sub-parts function you can now immediately place the
copy at the right position in the drawing. After function call a preview of the copy will be displayed at the cursor. Spe-
cify a fitting point in the preview, and then specify the position of this point in the drawing. Instead of a point option
you can also choose to place the fitting point in the origin (0, 0, 0) of the part coordinate system.

Part attributes - Locking of item number in BIM drawings
If a drawing is active that has been created and processed with the Management + BIM functions, the Item num-
ber field in the Part attributes window will be locked.

Manual cleaning up of projects

New in the Projects menu is the Clean-up function.

This function cleans up the active project by searching for invalid article masters and removing them. The active
construction must be itemized and saved before using the function. Otherwise, a corresponding message will
prompt you to do so.

Using this function only makes sense if the parameter Clean up project when saving at PDM > Management +
BIM has been set to No. The default setting is Yes, i.e. whenever you save your drawing, invalid article masters will
be removed automatically.
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Checkup and Release of production drawings
Previously, production drawings could only obtain the Workflow status Checkup or Released if the associated
model drawing was loaded. Now, the Release and the Checkup functions can also be applied if a production draw-
ing is active.

If your answer to the query Release drawing including all parts? or Set drawing including all parts to "Checkup"?,
respectively, is Yes, the drawings and all parts contained in it will be set to the status Checkup or Released ,
respectively. When you load the associated model drawing, these parts will then be locked against processing
there.

Assigning of the attributes SACHNUMMER (Article number) and BENENNUNG (Designation) via FTD
templates
If you want to create the HELiOS attributes SACHNUMMER (Article number) and BENENNUNG (Designation) from
template files, open the Configuration Editor, choose PDM > Management + BIM > Production drawings and set
the parameter Create HELiOS attributes from FTD file to Yes. These templates could previously be edited with the
Steel Engineering function Edit templates for part annotation.

As of HiCAD 2016 SP2 the new Templates, Attribute assignment function will be available for this. You can

find the function at Steel Engineering > Further functions > Settings > ....
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Template file Settings for the Pre-setting

BIM_PDM_WSD_
Assembly_
ArticleNumber.ftd

Configuration of the HELiOS document
attribute SACHNUMMER (Article num-
ber) for detail drawings of assemblies
(assemblies with one main part)

{Total quantity (Part attribute)} x {Article
number (Part attribute)}

BIM_PDM_WSD_
Assembly_Desig-
nation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of assemblies (assem-
blies with one main part)

%TS(TEXTE_STB401) {Item number (Part
attribute)}

%TS(TEXTE_STB401) stands for the con-
tent of the text key STB_401 which is the
text Item No.:

BIM_PDM_WSD_
Beam_
ArticleNumber.ftd

Configuration of the HELiOS document
attribute SACHNUMMER (Article num-
ber) for detail drawings of beams

{Total quantity (Part attribute)} {Article
number (Part attribute)} x{Länge (Part
attribute)}

BIM_PDM_WSD_
Beam_Desig-
nation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of beams

%TS(TEXTE_STB401) {Item number (Part
attribute)}

BIM_PDM_WSD_
Multi_Desig-
nation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of multi-part beams

%TS(TEXTE_STB401)

BIM_PDM_WSD_
Part_ArticleNum-
ber.ftd

Configuration of the HELiOS document
attribute SACHNUMMER (Article num-
ber) for detail drawings of general parts

{Total quantity (Part attribute)} x {Article
number (Part attribute)}

BIM_PDM_WSD_
Part_Desig-
nation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of general parts

%TS(TEXTE_STB401) {Item number (Part
attribute)}

BIM_PDM_WSD_
SheetMetal_
ArticleNumber.ftd

Configuration of the HELiOS document
attribute SACHNUMMER (Article num-
ber) for detail drawings of Sheet Metal
parts

{Total quantity (Part attribute)} x {Article
number (Part attribute)} x{Length of 2-D
development (Part attribute)} x{Width of 2-
D development (Part attribute)}

BIM_PDM_WSD_
SheetMetal_
Designation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of Sheet Metal parts

%TS(TEXTE_STB401) {Item number (Part
attribute)}

BIM_PDM_WSD_
SteelPlate_
ArticleNumber.ftd

Configuration of the HELiOS document
attribute SACHNUMMER (Article num-
ber) for detail drawings of Steel Engin-
eering plates

{Total quantity (Part attribute)} x {Article
number (Part attribute)} x{Length(Part
attribute)} x{Width(Part attribute)}

BIM_PDM_WSD_
SteelPlate_Desig-
nation.ftd

Configuration of the HELiOS document
attribute BENENNUNG (Designation)
for detail drawings of Steel Engineering
plates

%TS(TEXTE_STB401) {Item number (Part
attribute)}
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Drawing function group

Auto-create / update drawings

At Management + BIM > Drawing > ... you can find the new AutoCreate/Update function.

In contrast to the Create/Update Drawing - Manual Settings function, the settings for drawing derivation (i.e.
for drawing sheets, views, view groups etc.) are not be specified in the dialogue, but are loaded from the cor-
responding settings files. This means that the Drawing derivation window will not be displayed here. In this way,
drawing creation can be speeded up.

By default, the following settings files are supplied with HiCAD:

n BIM_WSD_Default_IndividualPart.DAT for individual parts

n BIM_WSD_Default_Assembly.DAT for assemblies

n BIM_WSD_Default_Bolted_Assembly.DAT for bolted assemblies

n BIM_WSD_Default_Welded_Assembly.DAT for welded assemblies

The files are located in the HiCAD sys directory.

Besides the option to use the predefined settings files supplied with HiCAD, you can also create, depending on the
respective usage/part type, your own settings files.

Set / withdraw 'Checkup' status of assemblies

As of HiCAD 2016 SP1 you have the option to assign the Workflow status Checkup to the drawings of individual or
several assemblies. This also includes the sub-parts of the assemblies. Likewise, you can withdraw the assigned
status if desired. For this to happen, you can use the functions beneath Checkup shown below:

Derive assemblies

Use the new Derive, active assembly(-ies) with sub-parts function to derive (copy) a new assembly from the
active assembly (also structure assemblies) including all its sub-parts. A prerequisite for this is that the assembly
has been released.

When the copy of the assembly is created, please note the following:
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n Article masters and item numbers will be deleted during the derivation.

n The linked documents, i.e. the drawings, will not be copied.

Settings in the Configuration Editor

Production drawing for unprocessed beams

Depending on the corresponding feature entries, you distinguish between processed and unprocessed beams in
your model drawing. For example, a lengthening, trimming, or moving points in a rectangle will not make the beam
a "processed" beam. All other functions, e.g. as bores, subtractions, notches etc. on a beam will make the beam a
"processed" beam.

The following settings are possible:

n Yes
Unprocessed beams will also be considered for derived drawings. This is the default setting.

n No (cuts are no processings)
The HELiOS link No drawing required will be assigned to unprocessed beams when the model drawing is
saved. This means that no drawings will be created for these beams. Cuts are not interpreted as processings,
i.e. they will
not be considered for derived drawings.

n No (cuts are processings)
The HELiOS link No drawing required will be assigned to unprocessed beams when the model drawing is
saved. This means that no drawings will be created for these beams. Cuts are interpreted as processings, i.e.
they will be considered for derived drawings.
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Major Release 2016 (V 2100)

Licensing

BIM functionalities for HiCAD industry suites and modules

The BIM functionality will be available for the following product combinations:

n HiCAD Steel Engineering Package + HELiOS Engineer+ (as of HiCAD 2015, SP2)

n HiCAD Steel Engineering + HELiOS Engineer+ (as of HiCAD 2016)

n HiCAD Steel Engineering + HiCAD Stairs + Railings + HELiOS Engineer + (as of HiCAD 2016)

n HiCAD Metal Engineering + HELiOS Engineer+ (as of HiCAD 2016)

n HiCAD Sheet Metal professional + HELiOS Engineer+ (as of HiCAD 2016)

n HiCAD Sheet Metal suite + HELiOS Engineer+ (as of HiCAD 2016)

n HiCAD Sheet Metal suite premium + HELiOS Engineer+ (as of HiCAD 2015, SP2)

n HiCAD Steel Engineering suite + HELiOS Engineer+ (as of HiCAD 2015, SP2)

n HiCAD Steel Engineering suite premium + HELiOS Engineer+

n HiCAD Metal Engineering suite + HELiOS Engineer + (as of HiCAD 2015, SP2)

n HiCAD Metal Engineering suite premium + HELiOS Engineer+ (as of HiCAD 2015, SP2)

n HiCAD Mechanical Engineering suite premium + HELiOS Engineer+ (as of HiCAD 2015, SP2)

n HiCAD Student + HELiOS Engineer+ (as of HiCAD 2016)

n HiCAD Trainee suite + HELiOS Engineer+ (as of HiCAD 2016)

Configuration

HicadBIMConfig.EXE replaces HeliosBIMConfig.EXE

Previously, the tool HeliosBIMConfig.EXE was used to perform updates for the database and the database links.
This tool has been replaced with the tool

HicadBIMConfig.EXE.

Due to the enhanced release functionality, customers who have already used the Management+BIM module
before HiCAD 2016, must execute the HicadBIMConfig.exe tool in the HiCAD EXE directory once before they start
working with with HiCAD 2016. In this way it is ensured that links without relevance will be created, and that the
release relevance works properly when working with the new functions. Customers who use the Management+BIM
module of HiCAD 2016 for the first time do not need to do this, as the relevant database links will then be auto-
matically correct.

Individual part type - Mounting or Workshop

You often distinguish between production processes where parts are welded in a workshop and production pro-
cesses where parts are sent to a construction site after processing for mounting tasks.
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Such "mounting parts" can be beams, profiles, plates, sheets, and general parts, and are called "loose parts" in
HiCAD. Such "loose parts" are parts that do not belong to a BOM-relevant assembly in which an assembly main part
has been defined (welding assembly).

Use the settings at Management + BIM > Individual part type in the Configuration Editor to achieve that these
parts will be automatically recognized by HiCAD during detail drawing creation and marked correspondingly in the
title block of the drawing.

Manage projects

Copy projects

Projects can now be derived from existing BIM projects at the push of a button, with all articles and documents
complete with all links. Even documents which do not belong to the project, such as standard parts, will be con-
sidered.

To do this, use the new Copy project function (Management+BIM > Project > New...).

Production document creation

Automatic creation of DXF-/PDF files during a workflow

For production drawings you have now the option to create DXF and PDF files either

n during Checkup or Release, or

n during creation and updating

of the drawings. For this purpose, the Configuration Editor now offers additional setting options at PDM > Man-
agement + BIM:
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Combined functions

The functions

n Production

n Production documents - Update, All and

n Production documents - Update, via HELiOS

have been combined into one, central Production function. This function finds - depending on the current
settings in the Configuration Editor - all parts of the current drawing for which no production documents exist yet,
i.e. parts with the links

n Without DSTV-NC data

n DSTV-NCdata not up to date

n Without DXF data

n DXF data not up to date

n Without STEP data

n STEP data not up to date

and displays them in the searchmask of the HELiOS Desktop. There you can select the corresponding parts.

Automated processes for detail drawing creation

Previously, the Drawing derivation function needed to be performed repeatedly when generating detail drawings
into external drawings in order to ensure that all drawings are actually created.

Example:

In the Configuration Editor, the Main parts and sub-parts, if detail drws created for them option has been selec-
ted for the parameter Condition for 'Drawing is up to date'. Previously, the drawing derivation needed to be cre-
ated for assemblies, and then also for the main parts and sub-parts! Now, HiCAD automatically recognizes objects
that do not have a drawing yet, and lists them without you having to exit the Drawing derivationfunction.

Please see also Example 1, Step 6.
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Metal Engineering

Service Pack 2 2016 (V 2102)

Improved behaviour in the event of LogiKal crashes
The behaviour of HiCAD and LogiKal in the event of LogiKal crashes has been improved: While a restart of
HiCAD and LogiKal was formerly required in such cases, the interface will now be restored automatically and will be
available again immediately.

Service Pack 1 2016 (V 2101)

AutoSearch for LogiKal installations removed
The automatic search for LogiKal installations that previously took place when no path to a LogiKal installation does
no longer take place for performance reasons.

This may require an explicit entering of the correct path to the LogiKal installation in the settings.

Major Release 2016 (V 2100)

New menu structure, new functions
The arrangement of functions on the Metal Engineering tab has changed. A logical restructuring has taken place -
for example, functions that manage parts in HiCAD and functions for LogiKal items have been arranged into one
group.

All functions for the creation or the import of parts in HiCAD can now be found in the New function group, functions
for the processing of metal and glazing constructions can be found in the Process function group. These groups
replace the previous function groups Metal Engineering, 3-D, LogiKal, 3-D. and Process, LogiKal 3D .

Update functions for parts, as well as the Import/ Export between HiCAD and LogiKal can be found in the same-
named function groups on the Ribbon tab.

New is the Transfer HiCAD processings to LogiKal function. With this function you can not only transfer
changes made in LogiKal to HiCAD, but, conversely, also transfer processings made in HiCAD (circular bores,

slots, rectangular holes, blind holes, threads) to the corresponding LogiKal item via .
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The Report function in the Others function group allows you to call the LogiKal report for the active part (or a
multiple selection pf parts).

Change item from sketch subsequently

When you choose Metal Engineering > New > Sketch to create a glass element or a facade in a sketch, a
feature log entry will be created for the sketch of the LogiKal item. Via this feature entry you can modify the sketch
subsequently, e.g. you can change its dimensions, which will also change the dimensions of the corresponding
LogiKal item with only a few mouse clicks.

Purpose for new sketches in the Metal Engineering grid
HiCAD automatically assigns a purpose to planar sketches upon their creation. One distinguishes between

n Purpose = Part

n Purpose = Create/Edit

Sketches with the purpose Create/Edit are, in principle, "auxiliary elements" from which other parts, processings
and sectional views, detail views or cut-outs. Sketches with this purpose are visualized with broader lines in the act-
ive view. They are also visible in shadedmodels.

Sketches with the purpose Part are regarded as "normal" parts that are used as elements of the drawing. They dis-
tinguish themselves from sketches with the purpose Create/Edit as follows:

n In cut-outs, sectional views and detail views the sketch will be cut.

n The sketches have no special representation and are not shown in shadedmodels (without edges).

n The sketchmay contain technical tools such as centre lines, crosshairs etc.

In the Configuration Editor, at System settings > Sketches > Purpose for new sketches in ME grid (for a working
with the Metal Construction plugin) you can specify which of the two purposes is to be assigned when a new sketch
is created.
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The default setting is Always Create/Edit.
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Plant Engineering

Service Pack 2 2016 (V 2102)

New/changed parts

Further macro variants replaced with feature variants

The following macro variants have been replaced with feature variants:

n ASME_REDUEX.vaa

n EN10253-2-A_REDUCER_EXC.vaa

n EN10253-2-B_REDUCER_EXC.vaa

n EN10253-4-A_REDUCER_EXC.vaa

n EN10253-4-A_REDUCER_EXC_STR.vaa

n EN10253-4-B_REDUCER_EXC.vaa

n EN10253-4-B_REDUCER_EXC_STR.vaa

The new variants also support the insertion option Create hollow body, with all available details. If the option is act-
ive, the transitions will be slightly filleted:

Create hollow body with all available details - (1) inactive, (2) active

New ASME parts

Many new ASME parts are available - mostly ASME fittings with flange connections and ASME flanges.

The following additional Standard Part feature variants were created:
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n ASME_2004_PIPE.vaa

n ASME_2012_CAP.VAA

n ASME_2012_CROSS.VAA

n ASME_2012_CROSS_RED.VAA

n ASME_2012_ELBOWLR_180.VAA

n ASME_2012_ELBOWLR_45.VAA

n ASME_2012_ELBOWLR_90.VAA

n ASME_2012_ELBOWLR_RED.VAA

n ASME_2012_ELBOWSR_180.VAA

n ASME_2012_ELBOWSR_90.VAA

n ASME_2012_REDUCER.VAA

n ASME_2012_REDUCER_EX.VAA

n ASME_2012_TEE.VAA

n ASME_2012_TEE_RED.VAA

n ASME_2013_BRANCH45_FLANGED150.VAA

n ASME_2013_BRANCH45_FLANGED300.VAA

n ASME_2013_CROSS_FLANGED150.VAA

n ASME_2013_CROSS_FLANGED300.VAA

n ASME_2013_ELBOW45_FLANGED150.VAA

n ASME_2013_ELBOW45_FLANGED300.VAA

n ASME_2013_ELBOWLR_FLANGED150.VAA

n ASME_2013_ELBOWLR_FLANGED300.VAA

n ASME_2013_ELBOWSR_FLANGED150.VAA

n ASME_2013_ELBOWSR_FLANGED300.VAA

n ASME_2013_LWNFLANGE150.vaa

n ASME_2013_LWNFLANGE1500.vaa

n ASME_2013_LWNFLANGE2500.vaa

n ASME_2013_LWNFLANGE300.vaa

n ASME_2013_LWNFLANGE400.vaa

n ASME_2013_LWNFLANGE600.vaa

n ASME_2013_LWNFLANGE900.vaa

n ASME_2013_REDUCER_EX_FLANGED150.VAA

n ASME_2013_REDUCER_EX_FLANGED300.VAA

n ASME_2013_REDUCER_FLANGED150.VAA

n ASME_2013_REDUCER_FLANGED300.VAA

n ASME_2013_TEE_FLANGED150.VAA

n ASME_2013_TEE_FLANGED300.VAA

n ASME_2013_Y-PIPE_FLANGED150.VAA

n ASME_2013_Y-PIPE_FLANGED300.VAA

n ASME_BLFLANGE150.VAA

n ASME_BLFLANGE1500.VAA

n ASME_BLFLANGE2500.VAA

n ASME_BLFLANGE300.VAA

n ASME_BLFLANGE400.VAA

n ASME_BLFLANGE600.VAA

n ASME_BLFLANGE900.VAA

n ASME_LAPPEDFLG150.VAA

n ASME_LAPPEDFLG1500.VAA

n ASME_LAPPEDFLG2500.VAA

n ASME_LAPPEDFLG300.VAA

n ASME_LAPPEDFLG400.VAA

n ASME_LAPPEDFLG600.VAA

n ASME_LAPPEDFLG900.VAA

n ASME_SOFLANGE150.VAA

n ASME_SOFLANGE1500.VAA

n ASME_SOFLANGE300.VAA

n ASME_SOFLANGE400.VAA

n ASME_SOFLANGE600.VAA

n ASME_SOFLANGE900.VAA

n ASME_WNFLANGE150.vaa

n ASME_WNFLANGE1500.vaa

n ASME_WNFLANGE2500.vaa

n ASME_WNFLANGE300.vaa

n ASME_WNFLANGE400.vaa

n ASME_WNFLANGE600.vaa

n ASME_WNFLANGE900.vaa

In case of an update these parts may require to be entered into the database (or the HiCAD catalogue, respectively)
first. For this, corresponding archive file lists are available via DBPlantDataImport and PartDataAutoSync:

n ASME_B16-5_Blindflanges.lst

n ASME_B16-5_Lapped_Flanges.lst
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n ASME_B16-5_Slip_On_Flanges.lst

n ASME_B16-5_Weld_Neck_Flanges.lst

n ASME_B16-5_Flanged_Fittings.lst

ERMETO parts

In HiCAD 2016 SP2 the ERMETO parts have been revised, to allow a displaying of the parts as separate parts both in
the drawing and in BOMs.

The revised ERMETO variants can be found arranged by series in the files

n EO_LL.lst

n EO_L.lst

n EO_S.lst

The previous ERMETO_O variants are no longer supplied.

Operation

Preview for the insertion of pipe parts and components

When you insert pipe parts and components a shaded, semi-transparent preview of the part will be displayed (as is
the case when inserting other 3-D parts).

Changes / enhancements in HELiOS

Revised HELiOS masks for classification of article masters in Plant Engineering

The HELiOS masks for classification of article masters in Plant Engineering have been revised and now contain a 3-
D image and a sectional view of the chosen part type. The advantage of the new mask consists in the provision of
additional, technical relevant attributes on the component masks (e.g. for Pumps) and a reliable assignment of geo-
metric parameters.

Classificationmask - Branch, round
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Classificationmask - Vessel
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New HELiOS attributes

In conjunction with the revised HELiOSmasks, 5 new attributes for plant Engineering are now available:

Attribute name Benennung

FOERDERHOEHE Delivery height (of a pump)

FOERDERMENGE Delivery volume (of a pump)

NPSH NPSH (Net Positive Suction Head) value of a pump

P_NENN Nominal performance (of a pump)

TEMPERATUR Temperature (for valves)

To add the new attributes to your HELiOS database, use the DBPlantDataImport.exe tool. There you can find the
Update HELiOS for Plant Engineering function.
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Part Tools

Bolted flange connections for own parts or variants

You can use the Flange connection, bolted functions of the Plant Engineering module to place boltings on flange
connections. To ensure that the boltings match the flanges, the functions will evaluate the variables of the part vari-
ant to which the flange belongs. This also needs to be considered if construct your own parts/variants with flange
connections, because otherwise, problems will occur during their processing with the flange connection functions.

The following table shows the lists of variables. The
second place of the variable's designationmust match the connection number. The list here refers to the example
of the first connection of a part.

B1 Thickness of flange plate (B1 = C1 + F1)

C1 Thickness of flange plate (without collar)

F1 Thickness of collar

A1 Number of bolts

K1 Diameter of bore circle

D12 Bore diameter

L Part length (not connection-specific)

Hence, the variables of the second connection will have the designations B2, C2, F2, A2, D22.

Additional, part-specific rules apply during evaluation:

1. If the variables C1 and F1 are defined in a loose flange, the grip length of the bolting will be determined via
the value C1+F1 istead of using B1.

2. For blank flanges the variable L instead of B1 will be used for grip length determination provided that L has
been defined.

The value of the variables NI (capital "N", capital "i", NO "1"!) is used as an additional attribute during creation or
querying of an article master in HELiOS. It represents the nominal diameter in Inches.
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Using connection type attributes

Connection type ID with priority information

In practice it can happen that two parts coincide which both specify additional parts to be inserted via their con-
nection type (often Fasteners). In such cases, the last but one digit of the connection will be interpreted as a priority
indicator. If one part is connected to another part, on the connecting points of which fasteners are already located,
the prioritization will be evaluated. If the part to be connected has a higher priority, the fasteners that already exist
on the connection will be removed and replaced with the part to be connected.

If the connection type of the part to be connected has a lower priority, its fasteners will not be inserted.

In cases of equal priority new fasteners will only be inserted if no fasteners exist on the connection yet.

The priority information will also be evaluated if a part does not supply any further elements. Even in such cases,
existing fasteners will be removed if the part to be connected has a connection type with a higher priority than that
of the existing connection. This means that a part can remove all fasteners because it acts as a fastener itself.

Connection type ID - List of part standards

Instead of specifying a standard in the supplement, it is also possible to specify a list of standards separated by
commas, e.g.

41002 1 5971010 Standard_A,Standard_B,Standard_C

During part search in the catalogue or in the HELiOS database the standards will be combined by means of an OR
condition. This means that not several parts are specified here, but the range of allowed parts will be extended
here.

Please note:

In the part standards list, whitespaces will be interpreted as allowed characters of a standard designation. There-
fore, no additional whitespaces must be entered to the right and to the left of the separating commas. Since the
standards are separated by commas, they must not contain any commas themselves.

Pipeline Tools

Merge pipelines

Use the new Merge pipelines function to merge several pipelines into one pipeline. You can find the function

at Plant Engineering > Plant Engineering Tools > Change > ....

Isometry/Pipe Spool Drawing

Dimensioning of bent pipes

Owing to the 2-D projection of isometric drawings it can sometimes be difficult to see which angle is located
between two straight pipe sections of a bent pipe.Therefore, a dimensioning of the respective angles between
those pipe pairs makes sense. Previously, this could only be done manually, using the common angle dimensioning
functions. To facilitate the processing of pipes on bending machines, HiCAD 2016 SP2 now also supports an auto-
matic generation of angular dimensions between all straight pipe segments of a bent pipe. To facilitate pipe
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processing on bending machines, HiCAD 2016 SP2 offers the the automatic generation of angular dimensions
between all straight pipe segments of a bent pipe. The Automatic dimensioning tab of the Isometry: Settings dia-
logue now offers the new Draw angular dimensions area with various setting options for this purpose. To activate
the automatic angular dimensioning, tick the Angular dimensions checkbox.

The following image shows two automatically generated angular dimensionings.

Use the other settings beneath Draw angular dimensions to determine the distance and the orientation of the
drawn angles.

Subdivision of isometry - Visualisation of already existing subdivisions

If you call the Specify division function in an isometry that has already been subdivided into several drawings,
the corresponding division points will be highlighted (Marking colour 3) as soon as the cursor is close enough at the
pipeline to be processed.

Placing of text objects

Text objects are additional, individual annotations in the isometry. They enable you to place property information or
comments directly next to parts. Previously, parts such as straight pipes could obtain additional annotations within
the isometry by selecting the part and typing the desired text for the text tag into a dialogue box that also offered
some font parameter selections. This tag was always placed centrally beside the pipe.

As of SP2 the Create assigned text object function offers the following, additional options for text placement:
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n Selection acc. to part (Default setting after function call)

Here the text object can be placed at an arbitrary point beside the selected part. Move the cursor over the part.
The location where the text object is to be created will be marked with a coloured sphere (Special colour Mark-
ing 3).

Click to apply a marked point. The Item number dialogue window (see 2.) will then be displayed.

n Selection acc. to points

As long as you are asked to place the text tag (i.e. as long as the Item number dialogue window has not been
opened), you can right-click to open the following context menu.

There you can find the Selection acc. to points function. This function allows you to specify the position of the
text object with the help of the HiCAD point options. A possible example would be the placing of the text object
next to the centre of a pipeline.For this to happen, you need to move the cursor near the desired pipe; the HiCAD
Autopilot will then automatically suggest point optionM. Confirm with a mouse click. After calling the function,
the part that is nearest to the current cursor position will be highlighted (Special colour Marking 1).
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You can now specify any point using the Autopilot or the Point options. This point needs not necessarily be loc-
ated on the part. After specifying the point, the Item number dialogue window will be displayed. If you want to
go back to the Selection acc. to part mode before specifying the point, right-click and choose the function in
the context menu.

Isometry settings

Texts/Lines

The distance of a text object without leader line (reference line) can now also be preset. The Texts/Lines tab of the
Isometry: Settings dialogue window now offers an additional option for this purpose:

Automatic dimensioning

To facilitate pipe processing on bending machines, HiCAD 2016 SP2 supports the automatic generation of angular
dimensions between all straight pipe segments of a bent pipe. The Automatic dimensioning tab of the Isometry:
Settings dialogue now offers the new Draw angular dimensions area with various setting options for this purpose:
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Service Pack 1 2016 (V 2101)

Working with HELiOS

Redesigned SML masks

In the article data search masks, the tabs for the Plant Engineering part classification via HELiOS have had a
redesign.
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Example - Branch, round
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Insertion of parts and components

Free placing of loose flanges

In previous versions, loose flanges could only be placed through an automatism during automatic placing of parts
on guidelines. From HiCAD 2016 SP1 onwards you can also add loose flanges to a pipeline manually.

Please note the following:

n The Connection type attribute of the HELiOS article searchmask is now editable. The default valie of the search
field er Default-Wert für das Suchfeld Connection type is 20000 and originated from the file sml_flansch.msk in
a standard installation. As loose flanges have the Connection type 20100, they will only be found if the search cri-
teria will be adjusted accordingly.

n The manual insertion will only work if the guideline mode has been deactivated in the Plant Engineering settings.

n As a loose flange can only be usefully connected at the end of a pipe part, you need to select, the Connection 1
to target connection option via the context menu (right-click) during insertion.

Insertion of hollow body nozzles into solid body vessels

When inserting a nozzle into a vessel, it was necessary in previous versions to select the type of representation, i.e.
a hollow body or a solid body, for the vessel in the Plant Engineering Settings. Now you have the option to select the
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desired type of representation for the nozzle.

Pipeline isometry

Improved readability

When generating pipeline isometries, HiCAD now avoids collisions of dimensionings and rise triangles if possible,
thus further improving the readability of the isometries.

Example - Before HiCAD 2016 SP1
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Example - as of HiCAD 2016 SP1

Message issued if data record assignment for connection types is missing

If a HELiOS data record has not been assigned to all connection types when you call the AutoGenerate drawing

(Iso) function, the references to data record attributes will be ignored. This may in particular lead to incom-
plete weld seam lists.

In such cases, a corresponding message will be displayed:
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Click OK to continue with the generation of the isometry.

Define missing assignments on the Connections tab of the Isometry: Settings dialogue window.

Connection type - Assigning of Data record and place of construction: (1) no assignment yet, (2) with assignment

Divide isometry - Visualisation of division points

When you use the Specify division function, the division points will now be graphically visualized. When you
move the cursor over the isometry, possible division points will be marked in a different colour (Marking colour 1).
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Left-click to accept a marked point as a division point. When you move the cursor away from the division point, its
colour will change (Marking colour 3).

If an already selected division point is selected again, the related division will be removed.

Right-click or press ESC to cancel the function without applying the selected division points. Press the middle
mouse button to apply the selected division points and exit the function.
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User-defined configuration for Isometry and Pipe Spool Drawing

In previous versions, the settings in the start dialogue of Isometry and Pipe Spool Drawing creation were saved for
each pipeline in the drawing. Besides this drawing configuration, HiCAD now offers the additional option to save
and re-use user-defined settings as XML files independent of the drawing.

For this purpose, the dialogue windows of the functions AutoGenerate drawing (Iso) and Generate pipe spool

drawing functions have been expanded accordingly.

The Isometry / Pipe Spool Drawing settings shown in blue frames in the below images can now be saved and re-
used as configurations.
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Drawing configuration

The settings specified for this pipeline will be saved, together with the drawing, for each pipeline of the drawing
when the isometry or the pipe spool drawing is saved. These are the so-called drawing configurations.

User-defined configuration

Besides the drawing configurations, you can also specify your own settings, independent of the the drawing, as

XML files and reuse them. To do this, click the Save configurations icon and enter the name of the XML file.
The following HiCAD sub-directories have been preset for the configuration files:

n PlantParts\IsoConfig for isometries and

n PlantParts\SpoolConfig for pipe spool drawings.

User-defined configurations can be reused at any time via the selection box.

Default configuration

And, finally, you have also the option to define a default configuration. To do this, specify the desired settings and

then click the Save as default configuration icon. The current settings will then be used as default settings for
the generation of isometries and pipe spool drawings. The file DefaultConfig.xml is located, like the user-defined
configurations, in the HiCAD sub-directory PlantParts\IsoConfig for isometries or PlantParts\SpoolConfig for pipe
spool drawings, respectively.
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Delete configurations

User-defined configurations can be deleted by choosing the corresponding configuration from the selection box

and clicking the Delete configuration icon. Drawing configurations and default configurations cannot be
deleted with this function.

Settings

Pre-selection

The option to restrict part search by a predefined wall thickness has been made available again. For this purpose,
the Pre-selection dialogue window has been expanded accordingly.
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Major Release 2016 (V 2100)

New part variants

Lisega Pipe clamps

The following Lisega Pipe clamps of the product group 4 are available as part variants (VAA files):

n Lisega Horizontal clamp Type 42

n Lisega Horizontal clamp Type 43

n Lisega Horizontal clamp Type 44

n Lisega Horizontal clamp Type 44 with strap

n Lisega Horizontal clamp Type 44 with belt

n Lisega Pipe way Type 49,

n Lisega Pipe way Type 49 for high temperatures

n Lisega Vertical clamp Type 45,

n Lisega Vertical clamp Type 46

The file LISEGA_Pipe_Supports_PG4.lst (in the HiCAD subdirectory PLANTPARTS) contains a list of all new LISEGA
part variants.

In case of an update, these parts may be entered into the database or the HiCAD catalogue, respectively.

Further DIN and ASME Flange connectors

n Flange connector 150 ASME B16.5

n Flange connector 1500 ASME B16.5

n Flange connector 2500 ASME B16.5

n Flange connector 300 ASME B16.5

n Flange connector 400 ASME B16.5

n Flange connector 600 ASME B16.5
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n Flange connector 900 ASME B16.5

n Flange connector DIN 28115 PN10

n Flange connector DIN 28115 PN25

The file ASME_16.5-LWN_Nozzles.lst (in the HiCAD subdirectory PLANTPARTS) contains a list of all new ASME
Flange connectors, the file DIN_28115_Nozzles.lst a list of the new DIN Flange connectors.

In case of an update, these parts may be entered into the database or the HiCAD catalogue, respectively.

Isometry / Pipe spool drawings

Text parameters - Changed dialogue

In all Setting dialogues offering a Text parameters button (e.g. Isometry/Pipe Spool Drawing > Settings >
Texts/Lines or ... > Lists, the following dialogue will now be used:
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Revised rise triangles functionality

Amongst other things, pipeline isometries in the Plant Engineering module serve the purpose of visualizing com-
plex, three-dimensional pipeline constructions in such a way in 2-D, that this visualisation still gives a good impres-
sion of the spatial pipeline routes. If a straight pipeline does not run parallel to a coordinate axis, rise triangles can
be inserted to convey a better impression of the spatial position of such a pipeline. Here, you distinguish between
vertical and horizontal rise triangles. To improve the visual representation of pipeline isometries, the Automatic
dimensioning tab in the Isometry: Settings dialogue offers significantly enhanced options for for rise triangles.
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Hatchings of rise triangles

Previously, rise triangles were always drawn with complete hatching. As a possible result, the rise triangle may be
optically too prominent in the drawing. Also, complete hatchings can often overlap with other drawing elements:
For example, the vertical rise triangle in the image below overlaps with the length dimensioning of the triangle
cathetus.

You have now the option to give rise triangles a partial hatching. For example, the horizontal rise triangle in the
image below has a partial hatching.The hatching itself has a triangular form, which is mathematically similar to the
outer, unhatched green rise triangle further down the page. The size of the hatched triangle can either be determ-
ined by specifying the Triangle length or the Triangle surface area - separately for horizontal and vertical rise tri-
angles. If you select the Triangle surface area option for the hatching, the length of the corresponding hatching
will be calculated by HiCAD accordingly. The effect of this setting is that an acute angle between hypotenuse and
start cathetus leads to a longer hatching distance that an obtuse angle. Visually, the hatching in both rise triangles
are equally intense. The result is a significantly enhanced impression of the three-dimensional course of the
pipeline.

Vertical and horizontal rise triangle

The vertical and horizontal hatching angles are automatically calculated to provide a best possible visual rep-
resentation. However, if you prefer angles deviating from the automatically calculated angles, you can specify the
desired difference angle in the Configuration Editor, at Plant Engineering > Isometry and Pipe spool drawing:

Offset triangles in front of pipelines if possible

If a straight pipe is not located in one of the three basic coordinates, you can, for the sake of a better spatial rep-
resentation, insert two rise triangles:

n a horizontal rise triangle in the XY-plane to convey an impression of the horizontal route, and

n a vertical rise triangle within the plane created by the Z-axis and the projection of the straight pipeline onto the
XY-plane to convey the vertical route

Previously, overlappings of the horizontal and the vertical rise triangles could occur in particular in isometric pro-
jections 1 and 4; especially if the decision was made to give a hatching to both rise triangle types, this could result
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in a very confusing graphical representation - totally contrary to the original idea of providing a better spatial rep-
resentation.

BeforeHiCAD 2016: Unsuccessful, complete hatching and no separate dimensioning

Now, If the two rise triangles overlap, the horizontal rise triangle will be mirrored (flipped) at its hypotenuse, thus
avoiding an intersection. If a pipeline isometry has several areas with two rise triangles, the number of all overlaps
of rise triangles will be determined in a first step. If more that half of the rise triangles overlap,
all horizontal rise triangles in the complete pipeline will be flipped. The advantage of this procedure is that the
cathetus between start point and base point of all horizontal rise triangles either runs in the direction of the positive
Y-axis or in the direction of the negative Y-axis. Thanks to this consistent orientation, the observer does not need to
re-orientate him/herself for each rise triangle and gets a better spatial impression of the situation.

HiCAD2016: Horizontal triangles flipped, separate dimensioning (no liner dimensions) for rise triangles and implied hatching
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Dimensions directly at triangle; introduction of a separate dimension distance

Normally, each of the three edges of a rise triangle obtains a linear dimension. The dimension figure of such a lin-
ear dimension indicates the length (in mm) in the corresponding spatial direction. The dimensioning of all rise tri-
angle edges by means of linear dimensions as well as the many other dimensions can sometimes make the
representation of pipeline isometries confusing.

To avoid this, HiCAD offers the option to place only dimension figures (instead of complete linear dimensions) next
to the edges of rise triangles. To do this, activate the Only write dimension figure next to rise triangles checkbox

Linear dimensions on rise triangles - No special dimensioning for rise triangles

When the linear dimensions are removed, the dimensioning of the rise triangles is much clearer, and the overall
view is less confusing. The dimension figure is placed centrally next to the relevant edge. The distance to this edge
can be entered as a separate dimension distance into the Rise triangles input field. If the distance is positive, the
dimension figure will be placed outside of the rise triangle, if the distance is negative, the dimension figure will be
placed inside of the rise triangle. If the value is 0, the dimension figures will be placed onto the relevant edge.

Rise triangles on edges only with dimension figure
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If the Only write dimension figure next to rise triangles checkbox is deactivated, linear dimensions will be used for
the rise triangles, but with the dimension distance entered in the Rise triangles checkbox. If the checkbox is deac-
tivated, and the same dimension distance is set for Rise triangles and 1st dimension line, the behaviour will be the
same as in older HiCAD versions (before HiCAD 2100.0).

BOMs

New template format for BOMs

The template format for the output of BOMs to Microsoft Excel has been revised. The new templates supplied with
HiCAD offer more output options that the old ones. Furthermore, it is now possible to create customized templates
for BOMs conveniently via adjustment of an Excel template. Already existing templates in the old format can, of
course, still be used.

Extensive information on the new BOM templates can be found in the Help of the Report Manager.
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P+ID

Service Pack 2 2016 (V 2102)

Configurable counter
The dialogue for the insertion of configurable counters has been expanded. The Number of digits input field now
offers the new selection option Generate via rule.

The generation expressions with counter (configurable counters) can be used:

n when editing multiple symbols

n for data mask objects (DMO)

n when editing data masks in the P+ID

n when editing data masks in the Symbol Editor

To open the dialogue, right-click on an input field in a symbol dialogue, and select Dialogue Type/Attribute in the
context menu. There, double-click the Configurable counter entry.

In the Number of digits field, select the option Generate via rule.

With the option Generate via rule you can determine the number of digits of the text key %XDIGITS. After selecting
this option, click the Generate button. In the context menu of the input field in the displayed dialogue window, you
can then right-click, choose Dialogue type/Attribute and insert a desired Generation rule.
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After confirming with OK, the rule will be displayed (e.g. %PIDAT(6)).

Further text keys can be called by double-clicking the Other key words icon in the Dialogue Type/Attribute dia-
logue window.
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%XCODE,
%XDIGITS

After selecting the key word you can call the context menu function Dialogue type/At-
tribute in the displayed dialogue window.

e.g. %XCODE(%PIDAT(6))

%TRIM,
%ONCE, %TSTR

After selecting the key word you can call the context menu function Dialogue type/At-
tribute in the displayed dialogue window.

e.g. %TRIM(%PIDAT(3200))

%FIRST After selecting the key word you can call the context menu function Dialogue type/At-
tribute in the displayed dialogue window.

e.g. %FIRST(%PIDAT(6):%PIDAT(3201):%PIDAT(3204))

%PREPOST After selecting the key word you can call the context menu function Dialogue type/At-
tribute in the displayed dialogue window.

e.g. %PREPOST(%PIDAT(6):%PIDAT(3201):%PIDAT(3207))

%PCT Via this key the character % will be displayed after evaluation.

%COLON Via this key the character : will be displayed after evaluation.

%OPNPAR Via this key the character ( will be displayed after evaluation.

%CLSPAR Via this key the character ) will be displayed after evaluation.

Security prompt after crash
In the Configuration Editor at Plant Engineering > P+ID you can specify the procedure after a crash.
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If you deactivate the Restore last state of editing after crash checkbox here, HiCAD will not search for files from
previous sessions in the working directory. If the checkbox has been activated, the following query will be dis-
played:

Wor king d i r ect or y con t a ins da t a f r om a d isr up t ed ed i t ing act i on . D o you want H iCAD t o t r y t o l oad t h is ed i t -
ing st a t e?

Visualize derivation relations in symbol libraries
You have now the option to visualize the derivation relations between data mask objects in a DMO library with the
help of inheritance graphs. You can scroll over the inheritance graph and highlight the inheritance paths, starting
from the node where the cursor is located, in a different colour. Also, you can define new derivation relations to the
current node in the process.

When you call the function, the inheritance graph will appear as shown below:
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When you move the cursor to a node, the inheritance paths from this particular node will be highlighted in a dif-
ferent colour.
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You can right-click and call the functions Determine base DMOs and Determine derived DMOs. These functions
allow you to define further base DMOs or derived DMOs form a particular node, while the inheritance graph will
remain visible.

If further base DMOs are to be set, the following arrow will be visible:
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If further derived DMOs are to be set, the following arrow will be visible:

Press the middle mouse button or the ESC key to cancel the function.

Service Pack 1 2016 (V 2101)

Derive symbols within DMO libraries
It is now possible to derive data mask objects (DMOs) from other DMOs according to a modular principle. This is
particularly useful if you want different templates to have the same attributes.
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RDS-PP attributes
To enable you to work with the RDS-PP designation system, a number of new attributes has been defined. These
can be combined into complete RDS-PP designations. As the attributes are able to depict the RDS-PP in a fairly
detailedmanner, it will be sufficient in most cases to directly specify values for the combining attributes.

n BL stands for "Breakdown level".

n LC stands for "Letter Code", i.e. the letter (non-numerical) portion of a breakdown level.

n DTG stands for "Digits", i.e. the numerical portion of a breakdown level.

RDS-PP filter/templates library
The filter/template library supporting the designation according to RDS-PP is the ISD_RDS_PP library. This library
makes extensive use of symbol derivation.

The image below illustrates the defined relations between derivations:

The actual DMO templates are located, together with their filters, in the symbol groups

n RDS_PP_FLT_0

n RDS_PP_TPL_0

n RDS_PP_FLT_1

n RDS_PP_TPL_1

These DMO templates derive from Base DMOs, which are subdivided into two groups.

In the ATTRIBUTES group, general attributes are defined. For example, it is ensured here that attributes for the
database link exist.

In the DESIGNATION COMPOSITION group the RDS-PP designation composition is emulated using the derivation
mechanism.
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Symbol libraries for RDS-PP designation
For the RDS-PP designation the symbol libraries RDS_PP_SYM0, RDS_PP_SYM1 and RDS_PP_SYM2 are avail-
able. They largely correspond with the libraries ISDDINSYM0, ISDDINSYM1 and ISDDINSYM2, except for some
changes to the attributes.

For symbols to which a designation according to IEC/PAS 62400 was assigned, this designation can be found on the
attribute Function BL2(LC), i.e the "Letter Code" portion of "Breakdown Level" 2 of the "Function" aspect.

Furthermore, you need to activate the From templates library option on the Symbol tab of the Settings dialogue
window.

Also, the symbols have the two attributes Designation1 (RDS-PP) and Designation2 (RDS-PP). These will obtain
values from the template DMOs of the RDS-PP filter/template library.

Using RDS-PP designations in P+IDs
To be able to use the RDS-PP designation defined in ISD_RDS_PP, you need to integrate the libraries RDS_PP_
SYM0, RDS_PP_SYM1, RDS_PP_SYM2 and ISD_RDS_PP into your project.

To do this, choose Settings on the P+ID tab. In the dialogue window, open the Configuration tab. Now, click Add
to integrate the libraries into the P+ID. In addition, you must deactivate the From templates library option on the
Symbol tab.

Furthermore, you need to add the template DMOs of the RDS-PP filters/templates library to the DMO sheet of the
project, to ensure that they will actually be used when the symbol is inserted. Call the Insert several function and
select the library.

RDS-PP attributes in title block libraries
In HiCAD P+ID the sheet-related attributes are stored on the title block symbol and can thus, for instance, also be
addressed via the text key %FRAME.The attributes of the title block symbols of the symbol library ISD_FRAME_
ENG.SZA contains the following entries for RDS-PP:

n Conjoint Designation (RDS-PP)

n Function GS0

n Function GS1

n Functional allocation (RDS-PP)

n Point of installation (RDS-PP)

n Point of installation GS0

n Location (RDS-PP)

n Document (RDS-PP)

Enhanced generation rules
The new keyword%TRIM() removes the whitespaces at the start and the end of evaluated generation rules.

Reset %COUNT text counters
If you have activated the From templates library option (on Symbol tab of Settings dialogue) for the selection of a
designation system, a list with all counters containing the keyword%COUNT will be displayed after selection of the
scope (Entire project, Same sheet number, ...). Select one or several rows in the list and confirm your selection with
OK. The selected text counters will then be reset, i.e. counters with%COUNT will be set to 0 and recalculated.
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Embed DMOs in modules
Portions of a P+ID can be saved as so-called "modules". When symbols with the keyword%DMO were contained in
the module, references to the DMOs were not embedded in the module in previous versions; as of Version 2101 the
references to DMOs will be preserved.

When inserting the module with the Insert module function, the embedded DMOs will then be taken over into
the DMO sheet of the new project.

Please note:

Only the regular DMOs will be embedded in the module, but not the DMO filters.
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Generation key %FRAME for DMO
During editing of DMOs the Title block symbol option is now also available in the Dialogue type/Attribute selection
list of the Edit symbol function.

Symbol identification
The Symbol tab of the Settings dialogue window contains the new Attribute button for the definition of identifiers
for different designation systems.

When you click this button, the following dialogue will be displayed:

Here you can select several attributes (dialogue types) serving as symbol uniqueness. 1 in the Role column stands
for the main dialogue type, 2 for sub-dialogue type. Up to 10 dialogue types can be defined here. Please note that
greyed out dialogue types cannot be removed with the Delete row function. During insertion or editing of a symbol
these attributes will be checked for uniqueness, if the Check symbol identification for uniqueness checkbox
has been activated.

The main dialogue types serving as symbol identifiers will, for instance, be used in symbol search result lists.

Major Release 2016 (V 2100)
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Cancel drawing of connection lines
If the start of a connection line is drawn in the wrong direction, an error message will be displayed and the con-
nection line jumps back to the first connecting point.

During drawing of a connection, you can press the middle mouse button to jump back to the previous point. If the
connection direction at the other end is not allowed, the connection line will jump back to the previous point. In
older versions, the complete connection line was deleted.

Dialogue for text parameter pre-settings
The possibilities of text parameter pre-settings for symbol dialogue texts were extended, and the corresponding dia-
logue window was changed accordingly. You will find the functions for the specification of text parameters at

n P+ID > Settings > Preset text parameters

n P+ID Library > Settings > Preset text parameters

n R+I-Symbol > Settings > Preset text parameters

After activating the icon, the Symbol text parameters dialogue window will be displayed.
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OK Save all changes and close dialogue window.

Cancel Discard all changes and close dialogue window.

for
marked
rows

Only active when P+ID
symbol in Symbol
Editor

Reset the parameters of the dialogue types with activated checkbox
to default values.

for
marked
rows

Only active when P+ID
symbol in Symbol
Editor

Define the parameters of the dialogue types with activated checkbox
as default values.

for
marked
rows

Only active when P+ID
symbol in Symbol
Editor

Apply the parameters from the graphics texts of the dialogue types
with activated checkbox , if corresponding text placeholders exist.

for
all rows

Define the parameters of all dialogue types as default values.

for
all rows

Reset the parameters of all dialogue types to default values.

On the left side of the dialogue window, all dialogue types are listed that are given in the current P+ID configuration
via the assigned attribute and dialogue type definitions.

Please note:

The text parameters for the dialogue types are saved to the file SymAttrTextParam.xml, in the same sub-directory
as the attribute and dialogue type definitions specified in the selected configuration, e.g. ..\PID\Lib-
s\AttDef\\ISDAttDef_eng.

It depends on the currently loaded P+ID object which dialogue types are activated in the list:

n A P+ID sheet: All dialogue types occurring in the data masks of the symbols on the sheet

n A P+ID library: All dialogue types occurring in the data masks of the symbols in the library

n A P+ID library symbol: All dialogue types occurring in the data mask of the symbol

If you right-click a dialogue type in the list, you will obtain the following context menu. The selected option refers
exclusively to the selected symbol type.
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Edit para-
meters

Opens the Text Editor:

Example

The text parameters of the selected dialogue type are displayed and can be changed.

Set para-
meters to
default
values

Resets the text parameters of the selected dialogue type to the default values.

Transfer
para-
meters

Allows you to transfer the text parameters of the selected dialogue type to other dialogue types.
Another dialogue window will then be opened. Proceed as follows:

1. In the left list, mark the dialogue types to which the text parameter pre-settings are to be
transferred.

2. In the right list. mark the parameters that you wish to transfer. Unmarked parameters will
be left unchanged. Use the corresponding button to set or delete all checkmarks in the
list.

3. Now, apply the selected text parameters with OK. If you select Cancel, the presettings
will be left unchanged. In both cases you will be redirected to the Symbol text parameters
dialogue window.

Take over
para-
meters
from text

Allows you to take over the text parameters from a 2-D graphic text of your choice. After calling
the function, use the crosshairs to select the text in the drawing the text parameters of which you
want to take over. After selecting th etext, the Text Editor will be opened, showing you the selec-
ted text and its parameters, and offering them for selection. You can apply the parameters with
OK, or discard them with Cancel.

Define
para-
meters as
default
values

Allows you to define the text parameters of the selected dialogue type as its default values.

Text parameters for KKS textbox
The text parameter setting on the Symbol tab of the P+ID Settings dialogue window is no longer available. Now,
the preset text parameters of the dialogue types Plant/Plant unit and Aggregate will be used.

Extended generation rules
The new generation rule contains text keys the purpose of which is a breaking up of character strings such as
XX000. The text has the format Format XX0000 and serves, for example, as a code for a symbol.
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Example 1:

%XCODE(%PIDAT(4)) returning the following after evaluation: BR, with (Dialogue type: 4) BR0000 being the
code.

Example 2:

%XDIGITS(%PIDAT(4):3) returning the following after evaluation: 4, with (Dialogue type: 4) BR0000 being the
code.

Example 3:

%XDIGITS(%PIDAT(4):3) returning the following after evaluation: 3, with (Dialogue type: 4) BR being the code.

Settings: Connection definitions
The behaviour of Default values and Cancel buttons on the Connections tab of the P+ID Settings dialogue window
has changed with regard to the connection definitions (see Online Help).

Example:

When you click on Default values:
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n Connection definitions created by the user will remain unchanged.

n Only connection definitions with names existing in the default connection definitions will be reset to the default
parameter values.

When you click on Cancel:

n Previously created connection definitions will not be deleted again.

Edit data mask in symbol library
To adjust the attributes of a symbol in a data mask library, it was formerly necessary to load the symbol into the Sym-
bol Editor first. This required a switching of drawing that had a somewhat disruptive effect on the working process.
Now, the context menu of a symbol contains the Edit data mask function:

This function opens the dialogue for an editing of the mask, with the restriction that connection attributes cannot be
changed. The number of connections influences the graphical representation of the symbol, with still can only be
changed via the Symbol Editor.

Data mask object filter

The context menu for data mask object filters contains two additional functions in the new Templates DMO menu
section:
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These functions facilitate the initialisation of the attributes Templates DMO and Templates DMO library:
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The two attributes are used when adding a data mask object (DMO) filter to a P+ID, in order to automatically find
the matching template data mask object, add it, and link it to the data mask object filter via a reference to the DMO
ID.

The Set template function expects the selection of a data mask object symbol, the name of which is entered in the
Templates DMO attribute. The currently edited library is entered into the Templates DMO library attribute. If no
data mask object was selected by mistake, a corresponding reminder will be displayed.

The Show template function evaluates the attributes Templates DMO and Templates DMO library, find the match-
ing data mask object and highlights it both in the drawing and in the ICN. If the filter refers via Templates DMO lib-
rary to a different library, a corresponding message will be displayed.

If the entered data mask object could not be found, a corresponding message will be displayed.

Part type ID selection in 'Edit symbol' dialogue
In previous versions, a separate dialogue was shown for the initialization of the value for the Part type ID attribute.
This dialogue has been replaced by a combo box.

New attribute types
There are two new attribute types, which facilitate the applying of data mask object filters (DMO filters) to specific
symbols.
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If you use data mask object filters, HiCAD will check upon insertion of a symbol in a P+ID whether the search pat-
terns on the attributes of the filter match the attributes of the inserted symbol. If this is the case, the attribute values
of the template that belongs to the filter will be copied to the symbol.

This means that it will be specified in the filter to which symbols the attributes of a template are to be copied. The
new attribute types Target symbol name and Target symbol type facilitate the restriction of a filter to a specific
range of symbols.

In the Target symbol name field you can directly enter the name of a symbol or enter a matching search pattern.
For example, a filter which contains the search pattern ?EMSR? as the value for the Target symbol name attribute
applies to the gauge symbols in the supplied library ISDDINSYM1_ENG.sza.

The Target symbol name attribute is handled in a special way: As the name is a very specific attribute of a symbol,
it is assumed that the template attributes have priority over other template attributes, and that these can be over-
written, without causing any conflicts.

In the Target symbol type field you can specify a symbol type for which a data mask object filter is to take effect,
i.e. for instance, only for pipe part symbols. The available symbol types can be selected from a combo box:

Designation according to templates library
The P+ID module has supported two plant engineering designation systems, namely, according to DIN and accord-
ing to KKS. For both systems, the rules for attribute value assignment were little flexible, which is, one the one
hand, a useful thing as it helps avoid errors, but on the other hand, prevents the utilisation of user-defined, deviating
designation systems.
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Thanks to the support of data mask object filters (DMO filters), you can now not only handle the existing des-
ignation systems in a muchmore flexible way, but also define your own designation systems.

Existing designation systems

The existing designation systems become more flexible, as they are now handled subordinately to the text key
expressions, which can be copied from the data mask object templates from a templates library to the symbol attrib-
utes. An example:

If you use the KKS designation system, the attribute Plant / Plant unit will be composed of the attributes Plant code
and Plant unit. If now a text key expression exists on the attribute Plant/Plant unit, i.e. %PARENT(%PIDAT(6)), for
example, HiCAD will recognize this constellation and refrain from using the fixed mechanism. Instead, the text key
expression will be evaluated, which results in the applying of the value of Plant/Plant unit of the superordinate sym-
bol.

This means that the text key mechanism will override the fixedmechanism.

User-defined designation systems

If you want to use neither of the two fixed mechanisms, activate the From templates library option beneath Ident
on the Symbol tab of the Settings dialogue window.
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Globally deactivate data mask object filter via the Configuration Editor
When a symbol is added in a P+ID, HiCAD will check whether a data mask object filter matches this symbol. If this
is the case, the attribute values of the corresponding template will be copied to the attributes of the symbol.

If you do not want this, you have the following options: You can either remove all data mask object filters from the
project, or deactivate this mechanism globally in the Configuration Editor, at Plant Engineering > P+ID > Use
DMO filter during symbol insertion.

Creation of user-defined template libraries
The first steps for the creation of a user-defined templates library are identical to those for the creation of a normal
symbol library. First, create a new P+ID library, which needs to be of the type "DMO library" to enable an adding of
data mask objects and data mask object filters.

Then, add data mask objects and data mask object filters, preferably by selecting the corresponding reference sym-
bols from the library ISDREFSYM.SZA:

1) Symbol for data mask object filter

2) Symbol for data mask object
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The following image illustrates the further procedure:

1. Search patterns determining to which symbols a filter is to be applied can be assigned to the attributes of a
data mask object filter. For this you use the Edit data mask function in the context menu or the Symbol
Editor.

2. Any texts or text keys can be assigned to the attributes of the Templates DMO. To do this, use the Edit data
mask function in the context menu or the Symbol Editor.

3. To ensure that the matching Templates DMO will automatically be provided and linked to a DMO filter that is
added in a P+ID, you need to specify in the library which filter belongs to which template. This assignment
can be conveniently defined with the Set template function in the context menu. This function sets the value
of the Templates-DMO for the Symbol name of the Templates DMO object. Furthermore, the name of the
library you have just edited will be assigned to the attribute Templates DMO library.If you prefer the assign-
ing to a template in a different library, fill in the attribute manually.

Supplied filter/templates libraries
Two filter/template libraries are supplied, namely, ISDDINDMO0_ENG.SZA and ISDKKSDMO0_ENG.SZA. These
emulate the designation system according to DIN and the KKS designation system.

Both libraries match the supplied symbol libraries. In particular, the template data mask objects are initialized with
attributes that provide the designation and counter predefinitions from the supplied symbol libraries.
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Default libraries
The DMO libraries ISDDINDMO_GER.SZA and ISDDINDMO_ENG.SZA have been added to the supplied default lib-
raries stored in the configuration files config_ger.dat and config_eng.dat which are integrated into a new P+ID.

These configuration files are located at PID\Admin\PidConfig of the HiCAD installation directory

.

Separate identifier text box in the Symbol settings
The 2-line KKS text box was previously only available if the KKS system was activated. To be able to use this text
box also when working with Templates DMOs, their availability has been enhanced.

Previously, the attributes that were entered into the text box were predefined. They can now be used in a more flex-
ible way via the corresponding settings on the Symbol tab.
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Example:

A Vessel that was inserted with the settings shown above would look as follows: 

New functions for the management of data mask objects
You can use the functions Edit sheet for data mask object or Edit DMO filter to specify which data mask objects or
data mask object filters are to be available in a P+ID. These functions allow you to add individual data mask objects
or data mask object filters.
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Three new functions for the handling of Templates DMOs have been added at P+ID > P+ID Sheet > DMO >
...). These functions affect the availability of data mask objects.

Insert
several

Displays a list of all templates libraries that exist in the P+ID. When you select some of
them and confirm with OK, all data mask objects that exist in these libraries will be added
to the available data mask objects. Already existing data mask objects will not be
changed or overwritten.

Reset
several

Displays a list of all templates libraries, at least one data mask object exists in the P+ID.
When you now select one or several of these libraries, the available data mask objects will
be overwritten with the state that was specified in the libraries.

This function enables you to conveniently undo your own changes, or apply changes to lib-
raries.

Delete
several

Displays a list of all templates libraries, at least one data mask object exists in the P+ID.
When you now select one or several of these libraries, the corresponding data mask
objects will be removed from the list of available data mask objects.

Hierarchy of data mask objects
It is now possible to subordinate one DMO to another DMO. At the same time, a DMO can be superordinated as a
so-called "Parent DMO" to other DMOs. A Parent DMO can, however, not be subordinated to another DMO.

Use the Edit sheet for data mask object function to display a list of DMOs in the DMO sheet in the dialogue win-
dow. With the functions Set parent, Show parent and Remove parent you can edit the hierarchy.

Use the corresponding function in the context menu of a subordinate DMO to apply the attribute value of its Parent
DMO via generation rule with the key word%PARENT.

New attribute icons
Icons for DMO and DMO filter:

Icon for DMO filter:

These icons are shown, for example, in the context menu dialogue Dialogue type/Attribute.
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ERPlus BOM
HiCAD now offers functions for the generation of DSTV-BOMs for the ERP system ERPlus.

DSTV-NC export
The dialogue window for DSTV-NC export has been revised and expanded by options for the configuration of the
order number, drawing number, item number and part number that can be specified directly in the dialogue win-
dow.
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Please note the following change:

In older HiCAD versions, only the configuration files DSTV_NC_Itemnumbertext.ftd for the Item number and
DSTV_NC_Partnumbertext.ftd for the Part number were used.

As of HiCAD 2016 Service Pack 2 (Version 2102) you distinguish between Main part (H part), Sub-part (W part) an
Loose parts, for which separate configuration files exist.

If you have worked with the corresponding configuration files in older versions, their content must be copied to
those for Main parts and Sub-parts: For the Item number DSTV_NC_H_Itemnumbertext.ftd(main part) and DSTV_
NC_W_ Itemnumbertext.ftd (Sub-part) or for the Part No. DSTV_NC_H_Partnumbertext.ftd (Main part) and
DSTV_NC_W_Partnumbertext.ftd(Sub-part), respectively.

DSTV_NC_Itemnumbertext.ftd and DSTV_NC_Partnumbertext.ftd each refer to Loose parts that do not belong
to any assembly.

Please also note that the configuration file stb_parameter.dat that was used in older versions does no longer exist.
The settings for the item number of the assembly can now be specified in the Configuration Editor.

Choose Steel Engineering > Further functions > Settings > Templates, Attribute assignment to adjust
the templates for attribute assignment for the DSTV export.
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The templates for attribute assignment for DSTV-NC export are FTD files, too; they are located in the sys directory
of your HiCAD installation. Supplied with HiCAD are the templates listed below:
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Templates file Settings for Pre-setting

DSTV_NC_
ORDERNUMBERTEXT
.FTD

Order number %TS(TEXTE760)

%TS (TEXTE760) stands for the content of the text key
TEXTE760, which is the text Order number:

DSTV_NC_
DRAWINGNUMBERTEXT
.FTD

Drawing number %TS(TEXTE1AN113)

%TS(TEXTE1AN113) stands for the content of the text key
TEXTE1AN113 which is the text Drawing number:

DSTV_NC_H_
ITEMNUMBERTEXT .FTD

Item number for
main parts

{Item number (Part attribute)}

DSTV_NC_H_
PARTNUMBERTEXT
.FTD

Paert number
for main parts

not allocated

DSTV_NC_
ITEMNUMBERTEXT .FTD

Item number for
loose parts

{Item number (Part attribute)}

DSTV_NC_
PARTNUMBERTEXT
.FTD

Part number for
loose parts

not allocated

DSTV_NC_W_
ITEMNUMBERTEXT .FTD

Item number for
attached parts

{Item number (Part attribute)}

DSTV_NC_W_
PARTNUMBERTEXT
.FTD

Part number for
attached parts

not allocated

DSTV_NC_
SIGNATURETEXT .FTD

Signature {Item number (Part attribute)}

DSTV_NC_FILENAME
.FTD

File name - NC {Item number (Part attribute)}

IFC: Attribute mapping
During the data transformation between IFC and HiCAD the attribute values from the original data will be trans-
ferred to permissible attribute values of the target system.

The rules according to which the Attribute mapping configuration is to be carried out can be defined for the import
and the export of IFC files.
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Interaction of CADKLICK with HiCAD
The ISD Group cooperates with the company KiM GmbH (http://www.cadclick.com/). Parts in supplier catalogues,
e.g. HILTI dowels, can now directly be inserted in HiCAD via the CADclick solutions.

The following example shows what such an integration could look like:
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Select the desired part, choose the target CAD system HiCAD and click on the part insertion button on the right. A
download onto the local Client will then take place ion the background (file format: STEP/SAT).

In HiCAD the Importing data.. message will be displayed. In the preview of the part, specify a point on the part, and
then specify the position of this point in the drawing. If desired, you can insert the part multiple times. To end the
insertion, press the middle mouse button.

Please note:

During part insertion, the order number of the part will be transferred to the HiCAD system attribute Order
No. (Attribute name $ON) . If you want the order number to be displayed also in the Part attributes mask for Stand-
ard Parts, you need to expand the system file BRW_3DTEIL_NORMTEIL.HDX accordingly.

Service Pack 1 2016 (V 2101) 

STEP: Export of standard parts
The STEP interface now offers the additional option activate or deactivate the export of standard parts.
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DSTV BOM: Decimal places for shipping dimensions, Assigning of mounting screws
You can now specify for the export of the DSTV BOM whether mounting screws are (in contrast to workshop screws)
to be grouped beneath the Z-set instead of the H-set.

Furthermore, you can now specify the number of decimal places for shipping dimensions.

DSTV-NC: Configurable file name
The DSTV-NC interface now offers the option to export, besides the HiCAD name or HELiOS data, the file name via
a .ftd configuration file.
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Warning symbol when exporting sketches
Many 3-D interface export formats offer the option to include sketches in the export. In this case, it is recom-
mended to activate the checkboxes Export free points and Export free edges; otherwise, the sketch may not be
exported completely.

If you forget to activate those two checkboxes, a warning symbol will appear next to the Export sketches check-
box:

PLMXML
The XML-based accompanying format PLMXML is a supplement to the JT interface. It allows the defining and stor-
ing of product structures and process data of complex assemblies in a readable form.

Import and export options are handled in the same way as in the JT interface.

IFC Export: Standard Parts
For the IFC export you can specify whether Standard Parts (bolts, screws, roller bearings, springs etc.) are to be
included in the export or not y activating or deactivating the Export standard parts checkbox.
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2D-DXF - Taking into account of UOMs
Thanks to an optimisation of the 2D-DXF interface, the unit of measurement (British or American inches) will now
be taken into account during import and export (via the $MEASUREMENT variable).

Update CADfix 10.0 SP2
Thanks to the CADfix update to Version 10.0 SP2, the import format version Inventor 2016 is now available in HiCAD
2016 SP1.
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3DPDF, Universal 3D and Product Representation Compact
A new export format, Product Representation Compact (.prc), is now available. It can be exported in the same
way as the formats 3DPDF (.pdf) and Universal (*u3d).

All three file formats offer various options for the export of thread bodies and the unioning of sheets.

IFC
A significant performance increase could be achieved for IFC export: Depending on the size of the drawing to be
exported, exports now take place 4 - 5 times faster.
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STEP
The STEP export functionality now offers the additional option to include sketches into the export.

Please note:

If the Export sketches option has been selected, you should also activate the Export free edges and the Export free
points options, to prevent that an "empty sketch" will be exported by mistake.
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HELiOS Desktop

Service Pack 2 2016 (V 2102)

ToDo list - Enhanced result list filter configuration options
The result list filter configuration options for ToDo lists have been enhanced: In the Object property area of the Con-
figure filter for result list dialogue window you will now find a new option, allowing you to display all objects created
by the group of the logged-on user (i.e. not only those that were created by the user him-/herself, but also those that
were created by other members of his/her group).

Editing in result lists
Similar to the editing of objects via the editing mode of their respective detail masks, attributes can also be edited
directly in result lists.

Just click to edit a result list row. You can, for instance, change the document number or article number, as well as
the folder and project names. Attributes such as Designation, the Document type or the Part type can also directly
be changed in the result list in this way, without having to call the editing window first.
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The possibility to edit result list rows can be set globally in the HELiOS Options.

If a direct editing of result lists is generally allowed in HELiOS, you can also specify for individual attributes within
the result lists whether they are to be editable or not.
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If the option has been deactivated, the checkbox column beneath the pen symbol will not be displayed in the
result list configuration.

The security prompt that is displayed after direct editing of result list rows can be suppressed and switched on again
if desired:

Article and Document Class Explorer
In addition to the Product, Project and Folder Explorer you can now add the new Article Class Explorer and Docu-
ment Class Explorer to the user interface: Choose View > Window at the top right of the HELiOS screen and activ-
ate the required Explorer.
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The tree structure of the respective Explorer contains all classes and sub-classes that were created for the cor-
responding object type. Identify a class in the Explorer and the result list will display all articles and documents that
have been assigned to this class.

Right-click to show and/or edit the classes, or to add new ones.
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Admin Tools
The Admin Tools tab now contains some additional functions: You can now also open the User and Workflow man-
agement tool EDBSETUP and the ReleaseNext tool for the listing and unlocking of documents directly from the
HELiOS Desktop.

The functions for Classification that were available in the Admin Tools tab of older versions have been with-
drawn due to the introduction of the new Class Explorers.

The Admin Tools tab is only visible if you have logged in as Administrator.

Workflow: Change owner
If you work with the classic Workflow (i.e. not with the Role Workflow), you have the option to change the owners
and groups of Workflows in the Edit workflow status dialogue window:
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Service Pack 1 2016 (V 2101)

New result list configuration options
The configuration of result lists is now evenmore convenient and easier to handle; some additional options are avail-
able, too.

Configure list
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Product Structure: Drag & Drop behaviour, tooltip infos
During all Drag & Drop actions, descriptive tooltip texts will be displayed:

If you drag an article into the Product Explorer where a Product Structure already exists, HiCAD will ask you whether
the existing Product Structure is to be replaced with the new one, or if the top article is to be added to the existing
Explorer contents.

On the Display tab of the HELiOS Desktop you can activate or deactivate this dialogue. If the corresponding check-
box has been deactivated, has been disabled, the contents of the Product Explorer will always be replaced with the
top article.

In this way you can also drag multiple selected articles into the Product Explorer.
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HELiOS Options: Display tab
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Product Structure: Sort sequence of Utilized articles
On the Result lists tab of the of the HELiOS Options dialogue you can specify for lists of the type Utilized articles
whether these utilized articles in the Product Structure context are to be shown with the same sorting as in the
Product Structure when they are called for the first time.

Sort sequence of articles by occurrence in product structure

Do not sort sequence of articles by occurrence in product structure
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Utilized articles: Displayed object state (index)
In the result list templates management for Utilized articles of the Product Structure you canmake a selection con-
cerning the displayed object state:

n Current state: Displays the current versions of the objects in the list.

n All states: Displays all versions of objects in the list.

n Current and last released state: The current and last released state of objects will be displayed in the list.

n Non-released state: All versions of objects which have not been released yet will be displayed in the list.

Utilized articles in structure version
The list of Utilized articles has been added to the Product structure versions window in the form of a new tab.

The working approach with the sort sequence and the displayed object state replaces the older context menu func-
tions Parts in 1-level assembly, Parts in assembly and Parts with non-released index.
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Structure version
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Enhanced HELiOS-URL

The context menu function Copy HELiOS URL saves the Head ID of a HELiOS object. Via the Head ID, the
corresponding HELiOS object can then also be called externally (e.g. from an external software) by means of the
HELIOS protocol (helios://).

Also, the HELIOS protocol can be used in conjunction with the document number, article number or project number
to identify and call the corresponding HELiOS objects (Documents, Articles, Projects).

Improved preview image concept
Due to problems and instabilities in connection with external viewer software that occurred in the past, the preview
image concept for graphic previews in detail windows of HELiOS has been improved.

Now, neutral formats are used, which offers a number of advantages:

n Through avoiding of third party software, the stability of HELiOS will no longer been compromised.

n No external components need to be installed and set up.

n Neutral formats are also very suitable for other processes, e.g. for Redlining.

n Neutral formats can also be generated for various document formats. This means that a consistent preview
mechanism exists for those formats, including a consistent operation (e.g. of the Viewer integrated in HELiOS).

Settings for the preview are still specified in the system file hel_preview.ini.

In the first step, the HELiOS Add-in for Inventor has been adjusted. The HELiOS Add-in saves the neutral formats for
previews when passing documents to the HELiOS Vault Server.
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Major Release 2016 (V 2100) 

The 'News' window
In order that you can take full advantage of the numerous new features and enhancements offered by HELiOS
2016, check out the videos explaining the new and changed HELiOS functionalities in our new 'News' window.

We will provide you with such videos with each Major Release and Service Pack to keep you constantly informed in
the best possible way.

Please note that you can configure the display of the News window at the bottom left of the window:

We recommend using the Show most recent news option to ensure that you will never miss any news about
HELiOS.

If you have selected the Show never option you can call the News window again at any time and change the dis-
play option by clicking on the “?” symbol at the top right and selecting Show news.

Terminological changes, Glossary
Some terms in the UI of HELiOS 2016 have been changed on the request of our customers.

To emphasize the difference between CAD parts and PDM parts, the HELiOS "Parts" have now be renamed to
Articles, since these are articles in the HELiOS database. "Part masters" are now called Article masters, "part mas-
ter data" are now called Article attributes.

Please note that due to technical backgrounds, designations such as "Part (R)" and link classes such as
"Bauteil-Teilegeometrie" (="Part-Part geometry") or "Bauteil-Dokument" (="Part-Document") in the standard data-
base supplied with HELiOS continue to exist for the moment.

The function for a revision of Articles or Documents with the assigning of a new index to them is now called Create
index. A "Modified drawing" still describes the process of a modification.

An overview of HELiOS-specific terms is now provided in an additional Glossary tab in the Online Help.
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Changes in the UI
Together with some adjustments of the HELiOS Desktop UI, some tooltips have also been revised. If you move the
cursor over a UI element, e.g. a tab, a tooltip containing a short description will be displayed.

When youmove objects, HELiOS will ask you confirm the Move operation:
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If desired, you can suppress this message by activating the same-named checkbox, or, on the Display tab of the
HELiOS Options, by deactivating the Show query for Move operation checkbox beneath Drag & Drop.

Furthermore, the overall performance of the HELiOS Desktop UI has been increased. This applies in particular to
masks using suggested values, the Utilized articles list and the transfer of very large product structures from the
CAD system (up to 6 times faster now).

The search mask technology has been incorporated into the links where-used lists for documents or articles. Right-
click the desired part or document and select the function in the context menu.

Search masks for links where-used lists
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Representation of assemblies in result lists
You have now various options for the representation of article numbers in the article result lists:

In the default setting, there is no graphical difference between individual part articles and assemblies (articles with
subordinate items). The corresponding attribute is "Number (VA_ObjectNumber)".

If you want this difference to be shown, you should activate the attribute "Number (VA_ObjectnumberWithIcon)" to
be displayed in the result list.

This slightly more performance-intensive option displays individual parts as a gearwheel symbol, and assemblies as
a double-gearwheel symbol.

In the image below, the leftmost column is the "Number (VA_ObjectNumber)" column, and the column to the right
of it is the "Number (VA_ObjectnumberWithIcon)" column:

Product structure
When selecting an index for the top article in the Product Explorer you can also make multiple selections. All selec-
ted top articles will be loaded into the Product Explorer one below the other. Old revision indices will be indicated as
such.
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Also, the Properties window of the Procuct Explorer displays (usage) attributes not only for super-ordinate items,
but also for the sub-items below them.

HELiOS Desktop

News Overview 259 / 278



Product Explorer and Properties window

The new product detail window allows you to display and edit items of the product structure, similar to the detail win-
dows of articles, documents etc.
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Display item: Product detail window

Besides the Utilized articles tab, you can also call the Utilized items tab in the result list area of the Product
Explorer and in detail windows. The list in this tab replaces the Product Editor (context menu functions Display in
Editor and Process in Editor) of older HELiOS versions.

Utilized items
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Attribute Editor
In the Attribute Editor you can assign attribute designations in different languages to attributes. You can add as
many languages as you like, and also change the designations of already existing attributes. The predefined des-
ignation will be preserved in the system, while the displayed designations can be repeatedly changed or deleted, for
as many languages as you like.

Updating of PDM parts in the product structure
New settings in the Database tab of the HELiOS Options dialogue window of the HELiOS Desktop allow you to
update

n individual PDM parts with a new index and

n released product structures.

The option Update PDM items during product structure sync simplifies the product structure synchronisation
between CAD and PDM insofar as it will be checked here whether PDM parts have a new index and if so, the
product structure will be updated accordingly. This means that the version of the article does not need to be
exchangedmanually with the current version.

If you set the Allow updating of released product structures to "Yes" (default: "No"), modified PDM parts (with new
index) can be updated in the product structure.
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Save to HELiOS from Windows Explorer
As of HELiOS 2016 you can save files of any type directly via the Windows Explorer to HELiOS by means of the new
Save to HELiOS function.
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New workflow dialogue
The new dialogue for the execution of workflow steps offers the option to assign the same workflow step to a selec-
tion of multiple documents or articles. A prerequisite for this is that all selected objects have the same object type,
the same workflow and the same workflow status.

Also, several steps can be executed in immediate succession, i.e. the window will not be closed in the process.
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HELiOS in HiCAD

Service Pack 2 2016 (V 2102)

Product structure synchronization
The Product structure synchronization functionality in HiCAD uses Look & Feel of the product structure in HELiOS
2016 SP2.

Changes in the product structure will be indicated by meaningful icons.

Thanks to the integrated result lists for utilized articles and items the product structure can also be displayed integ-
rated as a BOM and offers many editing options.

Other Export formats in the HELiOS Spooler
HiCAD drawing files (.SZA) files that have been saved as HELiOS documents to the database can be converted to
other formats from HELiOS.

This can take place in the HELiOS Desktop, or via the context menu of HELiOS documents in HiCAD.
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In the process, the data will be sent to the HELIOS Spooler which will perform the conversion and, if required, auto-
matic post-processings and the management of the foreign format files.

The selection list of the suggested formats can be individually adjusted and expanded. Besides the selection of
standard formats (DXF, DWG, STEP,3D-PDF and JT) you can also integrate conversions to IFC, DXF3D, DWG3D,
ACIS, PARASOLID, CATIAV4, CATIAV5, PROE, VDAFS and IGES3D.

266 / 278 ISD Group - HiCAD 2016

HELiOS in HiCAD



Further information about file conversion can be found in the HELiOS Online Help.
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Service Pack 1 2016 (V 2101)

Load via HELiOS
The HELiOS Combined search mask for the loading of drawings now offers the option to load documents in read-
only mode.

Multiple selections are also possible, i.e. you can load several selected documents as drawings into HiCAD.

Combined search mask

Title block update upon release
Upon release of a drawing from HiCAD, the CAD document will automatically be saved again with the updated title
block (Workflow step). In this way it is ensured that the correct and most recent status will be shown everywhere
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(i.e. also in the viewer).

This behaviour had already been implemented for the management of Steel Engineering drawings and some cus-
tomer-specific adjustments. It has become a standard with the release of HiCAD 2016 Service Pack 1.
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Major Release 2016 (V 2100)

New HELiOS masks
In HiCAD 2016 you will work with new HELiOS dialogue windows (e.g. search ans input masks) offering a wider
range of functions and enhanced user-friendliness.

Date and time in dialogue for unlocking of HELiOS objects
The dialogue for the unlocking of reserved HELiOS objects (the "ReleaseNext" tool) that may be called upon start of
HiCAD in conjunction with HELiOS, now has an additional column for the date and time of the reservation. This
allows an administrator to see for how long an object has been reserved.
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Product structure synchronisation

n In the database options of the HELiOS Desktop, user with administrator rights can specify whether individual PDM
parts in the product structure with a new index and released product structures can be automatically updated each.
When the default setting has been chosen, this is not possible.

n If you set the Database option Update PDM items during product structure sync to Yes, the product structure will
be updated accordingly when new indices of PDM articles exist. This means that no manual exchanging of the
older version with the revised version will be required.

n If you set the Allow updating of released product structures to Yes (default: "No"), modified PDM parts (with new
index) can be updated in the product structure.
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HELiOS Plot Manager

Service Pack 2 2016 (V 2102)

Other export formats
The conversion of SZA files via the HELiOS Spooler is now also possible for the following target formats:

n IFC

n 3D-DXF

n 3D-DWG

n ACIS

n Parasolid

n Catia V4 und Catia V5

n ProE

n VDAFS

n Iges

The set up takes place on the Client in the system file hel_fileconvert.ini.

Enhanced HELiOS Spooler Add-in for AutoCAD
The HELiOS Spooler Add-in for AutoCAD now offers the option to convert files.

For instance, you can automatically convert DWG files to DXF files via the HELiOS-Plot Management.

HELiOS Spooler - New PostProcessing variables
New variables for the postprocessing of print jobs are now available.

These allow special mappings, for instance, you can assign conversions by particular users to particular directories
via the variable "HEL_USERNAME".
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HELiOS MS Office Interface

Service Pack 2 (V. 2102)

Expanded attribute selection
The attribute selection dialogue for the placing of HELiOS attributes into your Office document has been adjusted to
the latest standards of the HELiOS Desktop.

This provides you with a wider range of attributes that can be inserted into title blocks. This also includes reference
attributes such as the Material ID.

Furthermore, you can use the Filter function to search for specific attributes.

Major Release 2016 (V 2100) 

Office 2016
The Office interface of HELiOS 2016 can be used with the latest Office Version 2016. Currently supported are Office
2010, 2013 and 2016 (32Bit and 64Bit).

ToDo List
The ToDo list of the HELiOS Desktop can now also be called via Office applications.
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MS Word with HELiOS ToDo list
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Linked articles
When you open Office documents that are linked to several articles, an additional dialogue for the selection of the
article context will be displayed.
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